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welcome

RHINOCAM2020

Prefer Printed Documentation? Check Here!

The RhinoCAM Profile-NEST module offers sheet nesting capability with 2-1/2 Axis Profiling
toolpaths.  Toolpaths can be nested individually or in groups with control over sheet size, layout
and thickness, with all of the cut material simulation capabilities of the MILL module.  Nesting
parameters include grain control, auto-tagging, orientation, nesting reports and more, all running
inside Rhino.   

For purposes of brevity, RhinoCAM-Profile-NEST will be referred to as Profile-NEST in all
subsequent references.  Also, Rhino refers to both Rhinoceros 5 or Rhino 6.

Profile-NEST also comes with numerous post-processors to output the programmed G-code to
some of the most popular machines in the market.  This online help system provides
comprehensive help topics as well as context sensitive ToolTips to help you become a productive
user of RhinoCAM.

On-line help compiled on: Sunday, January 26, 2020

1.1 understanding

Here is some additional information that will help you understand how Profile-NEST works:

· Profile-NEST allows you to nest 2 Axis Profiling toolpath operations onto one or more
nested sheets.  You can have multiple nest setups within the same Machining Job.  Each
are listed in the order they are processed in the Machining Job. 

· The Machining Job can have one or more Setups called  Operations to Nest.  If you
expand a Setup in the Machining Job you will see that it has a set of Nesting Parameters
assigned to it.  You can adjust these parameters individually for each Setup.  When you
Regenerate a Setup the toolpath operations contained within it are updated and its
associated nested sheets are also updated.  Regenerating a toolpath operation will also
update its associated nested sheets. 

· When Nested Sheets are generated they are listed under the Setup they are associated
with.

1.2 Workflow

Profile-NEST offers a quick and easy work flow for nesting 2 Axis Profiling toolpaths.  Working left
to right from the Nest tab, here are the basic steps:

https://www.mecsoft.com/guest/Support%20Documents/2020/RhinoCAM-2020/RC2020-Resource-Guide.pdf
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1. Define your Machine and Post Processor.

2. Define your Sheet parameters.

3. Set your Nesting Parameters.

4. Create your 2 Axis Profiling operations.

5. Generate your Operations to update your Nested Sheets.

6. Review your Nested Sheets.

7. Generate your Nesting Report if needed.

8. Simulate and Post Process.

1.3 Post-Processing

Once the machining operations have been created and verified, they can be post processed to
create G-code files.  These G-code files can then be sent to the controller of the machine tool to
drive the actual machine tool. 
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Quick Start

Quick Start Guides for each RhinoCAM module are available in both PDF and Video format.  Refer
to the following information to access these guides:

What's New

What's New in RhinoCAM 2020

Watch the What's New in 2020 Webinar!

The Complete Quick Start Video Play List

Here is a link to the complete 2020 Video Play List

How to Access the Quick Start Guide Documents

To help you quickly get started in working with each module, select one of the Help
buttons located on the RhinoCAM Learning Resources dialog.  

You will find:

· Quick Start Guides  

· What's New documents  

· Online Help links

The Quick Start Guides will help you step through an example tutorial which will
illustrate how to use the module.  To access the Learning Resources dialog:

1. From the Rhino Main Menu, drop down the Main menu and select Learn ...  

https://www.mecsoft.com/WhatsNew/WhatsNewInRhinoCAM2020.pdf
https://youtu.be/fFTtyiQQGNA
https://www.youtube.com/playlist?list=PLx9G05pFm0QKmKwKM3HEmCUk1AnRaHUe4
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To access the Learning Resources dilog in RhinoCAM

2. Select a document from the Learning Resources dialog to get started using the
module of your choice.  

 You can also select the Open Quick Start Files Folder button located at the bottom
of the dialog to open the Quick Start folder where the source files (start and
completed versions) are located.
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Learning Resources Dialog
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Resource Guide

Download this PDF Guide for a list of the available RhinoCAM Resources.

2020 RhinoCAM Resource Guide

The RhinoCAM 2020
Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Click Here to download this guide!

https://www.mecsoft.com/guest/Support%20Documents/2020/RhinoCAM-2020/RC2020-Resource-Guide.pdf
https://www.mecsoft.com/guest/Support%20Documents/2020/RhinoCAM-2020/RC2020-Resource-Guide.pdf
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User Interface

The RhinoCAM Profile-NEST module adheres to the Windows standard for user interface design
and integrated into the Rhino screen seamlessly.  

MILL Module Displayed

A screen shot of the RhinoCAM Profile-NEST module running inside of Rhino is shown
below:  

The Profile-NEST module running inside of Rhino

The RhinoCAM MILL Interface

There are 3 main interface objects created when MILL module is loaded.

1. RhinoCAM menu bar entry under Rhino menu bar

2. Machining Browser (Mops) window

3. Machining Objects (Mobs)  Browser window
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4.1 The Main Menu

RhinoCAM Main Menu

When RhinoCAM is loaded it will add a menu bar item, titled
RhinoCAM to the main Rhino menu bar.  Selecting this menu bar item
will display a drop down menu as shown below.

4.2 Profile-NEST Browsers

The Profile-NEST Browser is a dock-able window that allows management of various entities or
objects that can be created in the RhinoCAM Profile-NEST module. There are 2 browsers in
RhinoCAM – the Machining Operations Browser (Mops) and the Machining Objects Browser
(Mobs).  

Profile-Nest Browsers
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Profile-Nest Browser

4.3 Machining Browser

The Profile-NEST Operations Browser has two main modes of operation represented by tabs at
the top of the window. These are Nest and Simulate. Each tabbed view also incorporates a ribbon
toolbar at the top and a toolbar at the bottom.  These toolbars group all of the functions
associated with the type of object in the tab.
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Profile-NEST Browser

4.3.1 Toggle Browser Tabs

Tabs are available on the Machining Browser that allow you to toggle the display of both the
Machining Browser and the Machining Objects Browser.

Browser Toggle Tabs

Locating the Browser Toggle Tabs

   

Selecting this tab toggles between each module browser that you are currently licensed
to operate.  Select the button to toggle to the Profile-NEST Browser.
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Select this tab to toggle the display of the Machining Objects Browser.

4.3.2 Nest Tab

Selecting the Profile-NEST tab in the Machining Browser provides access to Machine, Stock and
Operations to Nest commands.  These commands are listed in the ribbon bar when the Nest tab is
selected.

The Machining Operations (Mops) Browser, Nest Tab

Profile-NEST Browser

Machine Setup Pane

This section allows you to define the Machine Tool, Post Processor and the Nested
Sheets.

Machine Tool Setup: Sets the Machine for 2½ axis, 3
axis, 4 axis and 5 axis operations.
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Set Post-Processor Options: Allows you to set the
Current Post Processor, posted file naming
conventions, posted file extension, program to
display the posted file.

Add Sheets by defining sheet size parameters or
geometry.

Stock Pane

This section allows you to define the Machine Tool, Post Processor and the Nested
Sheets.

Create Stock Model: Allows you to create Stock
geometry. User can also delete a Stock geometry by
selecting Delete Stock.

Align: Allows you to Align stock model to part and
locate WCS with respect to Part or Stock .  This
function is especially useful when the part model
and the stock model are created without regard to
their respective positional locations.

Define Stock Material: Allows you to select a
material from the material list.

Operations to Nest

This section allows you to create machining operations  The Profile-NEST module allows
you to create multiple 2 Axis Profile machining operations in a part file. This is a
powerful feature that allows you to create an entire sequence of machining operations
that is required in the nested sheet.  

Add a Work Zero to set the current work coordinate
location for machining.

Add a 2 Axis Profile toolpath operation to the Machining
Job. 

Set Nesting Parameters for the current Profiling Nesting
Machining Job.

Generate a Nesting Report of the current Machining Job.

Display Toggle Toolbar

This toolbar is located at the base of the Machining Browser and has the following
controls:
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Stock Model Visibility: Turn on/off stock model 

Material Texture Visibility: Turn on/off material texture
visibility

Toolpath Visibility: Turn on/off toolpath display

Hidden Toolpath Visibility: Turn the hidden portions of
toolpaths on/off.

Display Toolpath Levels: Displays tool path by Z levels

World CSYS Visibility: Turns on/off of World Coordinate
System display.

Machine CSYS Visibility: Turns on/off of Machine
Coordinate System display.

4.3.3 Simulate Tab

Select the Simulate tab to run cut material simulations and toolpath animations. This tab also
provides controls to vary the simulation speed, set the simulation preferences and toggle the
display state of various simulation components.

Profile Nesting Browser, Simulate Tab
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Profile Nesting Browser, Simulate Tab

Simulate Tab Functions

The following controls are available on the Simulate tab:

Create Stock Model: Allows you to create Stock
geometry. You can also delete a Stock geometry by
selecting Delete Stock. 

Perform Toolpath Simulation or Animation: Allows
you to perform cut material simulation with tool
animation.

Simulate Next Toolpath Block: Simulation is
performed in steps as defined by the display interval
in the simulation preferences.

Simulate Next Toolpath Z Levels: Simulation is
performed in separate Z levels.

Simulate to End: Simulation is performed without
updating the display until the end of the toolpath.
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Pause Toolpath Simulation: Pause/Stop the
simulation.

Stop Toolpath Simulation: Exits Simulation Mode.
Pause simulation before exiting simulation mode.

Simulation Speed: Varies simulation speed

Set Simulation Preferences: Provides access to
simulation preferences.

Simulate by Moves: Switches from Simulate by
Distance to Simulate by Motions.

Simulate Toolbar Functions

The following toolbar controls are available on the Simulate tab:

Part Model Visibility: Turn on/off part model display
during simulation.

Stock Model Visibility: Turn on/off stock model 

Material Texture Visibility: Turn on/off material texture
visibility

Toolpath Visibility: Turn on/off toolpath display

Hidden Toolpath Visibility: Turn the hidden portions of
toolpaths on/off.

World CSYS Visibility: Turns on/off of World Coordinate
System display.

Machine CSYS Visibility: Turns on/off of Machine
Coordinate System display.

Tool Visibility: Turn on/off tool display during simulation.

Holder Visibility: Turn on/off tool holder display during
simulation.  

Simulation Display State: Use this to select the display
state for the simulation.  Select from Default, Tool, Mop or
Texture.  See Machining Operation Properties for setting
unique simulation colors for each Mop (Machining
Operation) in your Machining Job.
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The status bar displays the progress of the operation currently being simulated and
number of Goto motions.

4.4 Machining Objects Browser

The Machining Objects Browser has two tabs located at the top to work with Tools and Knowledge
Bases.  Each tabbed view also incorporates a toolbar at the top.  The toolbars on each tab group all
of the functions associated with the type of object in the tab. 

The Machining Objects Browser can be toggled on and off by selecting the toggle button located at
the top left corner of the Machining Browser.  This toggle button is shown below.

The Machining Objects (Mobs) Browser

Locating the Machining Objects Browser toggle tab

The Machining Objects (MObs) Browser

The status bar displays the currently selected tool, spindle speed and cut feedrate.

Machining Objects Browser Tabs
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Tools tab:  Allows you to create, edit, tools and tool
libraries.

4.4.1 Tools Tab

Selecting the Tools tab under the Machining Objects Browser brings up the tool manager.  It lists
all of the tools currently defined as well as the tools that are in use in machining operations.  You
can edit a tool by double clicking the tool button in the browser. A tool can be deleted by
selecting the tool from the Tools browser, right click cut or use the delete key from the keyboard.

The Machining Objects (Mobs) Browser, Tools Tab

The Machining Objects (MObs) Browser, Tools Tab

RhinoCAM supports 2 types of tool library file formats *.vkb and *.csv (*.vkb is
recommended).

Tools Tab Functions

Create/Edit Tools: This button brings up the tool dialog that enables the
creation and saving of tools. All milling, drilling and user defined tools can be
created here.  Refer to Tool section for a detailed description on creating tools
and defining tool parameters.

Load Tool Library: The load tool library button enables the loading of a
previously saved tool library.  Refer to the following section for additional
information - Load Tool Library

Select Tools from Library: The select tool library button enables you to select
tools from a previously saved tool library.  Refer to the following section for
additional information - Select Tools from Library

Save Tool Library: This button enables the created tools to be saved in a tool
library file. The file can be saved in the desired directory and read in when
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required.  Refer to the following section for additional information - Save Tool
Library

Unload Tool Library: This button will unload the current Tool Library.

List Tools: The button brings up all the tool properties associated with the tools
currently recorded in the current MILL session.  Refer to the following section
for additional information - List Tools

Right-click Options on Tools

You can right-click on a Tool listed in the Mobs Browser to perform various functions. 
These are listed below:

Right-click Options on a Tool

Edit  
Displays the Create/Edit Tool dialog allowing you to edit the Tool parameters.

Rename  
Allows you to Rename the selected tool.

Cut / Copy / Paste  
These options allow you to Cut or Copy the selected Tool to the Windows Clipboard
and then Paste it back to the Tools list to create a new tool using the previous tool
as a template.
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Add to Library
This allows you to Add the selected Tool to an exiting Tool Library *.csv data file.

Preview
This will display a Preview of the selected Tool in the Graphics Window similar to
how the Tool displays during Simulation.  The Tool will display at the origin of the
MCS for the current operation. 

Tools Toolbar Functions

The following Tool Sorting rules (when set) will apply to both the Tools tab of the
Machining Objects Browser and the Create/Select Tools dialog.

Sorting Selector: This allows you to sort the tool list.  You can select No Sort or sort by
Name, Number, Type and Diameter.

Sort in Ascending/Descending Order: This icon acts like a toggle to switch
between Ascending and Descending sort order.

List on the Tool used in Machining Operations: Toggle this icon to list ONLY the
tools currently assigned to an operation.  Note: You must Generate an operation
for the assigned tool to be listed. 

If you do not see any of your tools listed, check to make sure this icon is
toggled OFF.  If no operations are using tools yet and this icon is ON, then

no tools will be listed!
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Tools Sorted by Name

Tools Sorted by Used

Tools Status Bar

The status bar displays the currently selected tool, tool tip radius & angle, spindle speed
and cut feedrate.

Status Bar, Tools Tab, Machining Objects Browser

4.5 Docking Browsers

Both Machining Operations Browser and the Machining Objects Browser windows are dock-able
windows.  This means these windows can be docked in any position in Rhino.  This section
describes the procedure to be used to dock both of these windows such that they are stacked
vertically.

Step 1: Launch the MILL Browser

From the Rhino main menu, select the RhinoCAM menu and then pick MILL.  This displays
the machining operations browser and by default is docked to the left half of the
application window next to the view bar.

Step 2: Display the Tools, Machining Objects Browser

Select the Tools Machining Objects button located on the Machining Operations Browser
just to the left of the Program tab. This displays the Machining Objects Browser next to
the operations browser.
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Toggle the Machining Objects (Mobs) Browser Display

Step 3: Drag & Drop the Browser

Selecting the title bar and holding the left mouse button down and dragging the browser
window  allows you to dock the browser to desired location. You can dock a browser
inside of another browser or have them docked side by side.

4.6 CAM Preferences

You can set various CAM Preferences that will be saved even after you exit the program. 
Select the Preferences icon from the Machining Browser.  When you install a new RhinoCAM

update you are choose to import your CAM Preferences from one version to the next.

The CAM Preferences Icon (in the MILL Module)
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Set CAM System Preferences menu item

The available Preferences include:

Geometry
Includes color preferences for Regions and Surfaces.  Show the dialog.  

Stock 
These include stock colors, stock edge display and stock transparency.  Show the dialog.

Cutting Tools  
Includes Tool colors, Tool display states and the default Tool Library preferences.  Show
the dialog.

Feeds & Speeds  
Includes Feeds & Speed preferences such as default values and other options.  Show the
dialog.

Machining  
Includes Arc Output, Drill Cycle Output, Toolpath Resolution and the default machining
Knowledge Base preferences.  Show the dialog.

Toolpath 
Includes Toolpath Colors and Toolpath Display preferences.  Show the dialog.

Simulation  
Includes Simulation Type, Mode, Accuracy, Transparency and other preferences.  Show
the dialog.

User Interface  
Includes General, Stock Information and Ribbon Style preferences.  Show the dialog.

Licensing 
Includes network licensing preferences.  Show the dialog.

4.6.1 Geometry

You can set the colors to display various objects using this dialog. To change each of the color
settings in this dialog select the colored button next to the item of interest. This will bring up the
color selection dialog, which can be used to choose the color needed. Once a color has been
selected the button will change its color to the selected one.
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Dialog Box: CAM Preferences > Geometry

CAM Preferences > Geometry

Region Colors

Containment Region
Use this color selector to set the display color for Containment Regions (i.e., your Control
Geometry).

Avoid Region
Use this color selector to set the display color for Avoid Regions (i.e., your Control
Geometry).

Surface Colors

Drive Surfaces
Use this color selector to set the display color for Drive Surfaces (5 Axis).

Check Surfaces
Use this color selector to set the display color for Check Surfaces (5 Axis).

4.6.2 Stock

You can set the simulation preferences using this dialog.  Note: Some options are not available in
XPR (Xpress) configuration.

Dialog Box: CAM Preferences > Stock

Users can set the simulation preferences using this dialog:
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CAM Preferences > Stock

Colors

Here you can set the stock colors. You can differentiate between cut and non-cut areas by
specifying different colors for them here.

Note: If the Simulation Display State is set to  then the Color assigned
using the Machining Operation Properties is used to display the cut stock.  Right-click on
an operation in the Machining Job tree and select Properties to set this color.

Stock Edges Display

This section allows you to control the Stock Edges Display states.  For example, you can
check the boxes to display Silhouette Edges and Sharp Edges as well as the Angle to
display for stock edges.  Silhouette Edges and Sharp Edge colors are set using the Colors
section of this dialog.  Experimentation is advised until you are comfortable with the way
your stock display.

Stock Model Transparency

Use this slider to adjust the Stock Model Transparency when the Program tab is selected
(i.e., when you are not simulating).

4.6.3 Cutting Tools

You can set the Tool Library to load on startup and also specify the location of your Tool Library
files.
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CAM Preferences > Cutting Tools

CAM Preferences > Cutting Tools

Cutting Tool Colors

Use the color selectors to set the default display colors for the cutting tool.  The Tool
Flutes, Tool Shank and Tool Holder can each be assigned a different.
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Tool Display

The cutting tool can be displayed as either Solid, Transparent, Wireframe or None by
selecting the desired option.  You can also toggle the display of the Tool Holder by
checking or un checking the box provided.

Tool Library Preferences

This defines your Tool Library preferences:

Always load last loaded tool library on startup  
If you check this box, every time RhinoCAM loads, the last loaded Tool Library will be
loaded automatically.

Default tool library path  
Optionally you can specify the file path for your default tool library files.  Note: It is
recommended that you save your custom tool library files to a location outside of the
RhinoCAM install path.  This will keep them from being overwritten when you install
new updates of RhinoCAM.

4.6.4 Feeds & Speeds

You can set the Feeds & Speeds preferences using this dialog.

CAM Preferences > Feeds & Speeds
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CAM Preferences > Feeds & Speeds

Load Feedrates for operations from

This allows you to select a preference option for loading Feeds/Speeds from table or
from tool or use defaults when creating a new operation.

Tool  
Selecting this option loads the feeds/speeds saved with the tool when creating a new
operation.

Table  
Selecting this option loads the feeds/speeds based on the material selected when
creating a new operation.

Defaults  
Selecting this option loads the feeds/speeds from the default knowledge base when
creating a new operation. If default knowledge base is set to undefined, the system
defaults would be used for loading feeds and speeds.

% s to use for transfer from computed cut feed
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These % values apply when using the Load from File option (i.e., commonly referred to
as the Feeds & Speeds Calculator) from either the Create/Edit Tools dialog of from the
Feeds & Speeds tab of any of the toolpath operation dialogs.  100% of the Cut Feed
specified in this dialog is applied and a percentage of the Cut Feed is used to populate
the remaining feedrates for Plunge, Approach, Engage, Retract, Departure and Transfer. 
You can set the % values to use here.

Feeds/Speeds Tracking Options

When you select the Load from Tool option from any of the toolpath operation dialogs,
the Feeds & Speeds specified for the active tool are populated into the Feeds & Speeds
tab of the operation's dialog.  You can check this box to perform this automatically when
new toolpath operations are created.

4.6.5 Machining

You can set the machining preferences using this dialog.

CAM Preferences > Machining
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CAM Preferences: Machining

Arc Output

Some NC machine controllers do not have arc, spiral and helical output (for example G2,
G3). For such type of controllers, the arcs that are generated in the toolpath can be
output as linear segments by selecting these check boxes.

Output Arcs as Linear Segments
If your controller does not support arc g-code motions, check this box to output arcs as
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linear segments.

Output Spiral Motions as Linear Segments
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

Output Helix Motions as Linear Segments
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

Toolpath Arc Fitting Control (If requested in Mop)

Some toolpath operations support Arc Fitting.  If supported, the option is located on the
Advanced Cut Parameters tab of the operation's dialog.

Maximum Arc Radius
Some toolpath operations support Arc Fitting.  You can enter here the Maximum Arc
Radius that can be created.

XY Plane
Check this box to Perform Arc Fitting .  The system will attempt to fit arcs along the
computer toolpath if they lie within the three principal planes (XY Plane, XZ Plane or YZ
Plane).

Tolerance (t)

XZ Plane
Arcs can be fitted to linear toolpaths that lie on one of the three principal planes XY, XZ
or YZ.  Check the box for which plane to fit arcs to.

Arc Fitting

YZ Plane
Arcs can be fitted to linear toolpaths that lie on one of the three principal planes XY, XZ
or YZ.  Check the box for which plane to fit arcs to.



RhinoCAM Profile-NEST 2020 Reference35

© 2020 MecSoft Corporation

Arc Fitting

Drill Cycle Output

This section refers to Hole Machining Drill Cycles.  

Always output Drill Cycles as linear motions.
Check the box if your wish to always output Drill Cycles as linear motions.

Tool Programmed Point (P)

The toolpath can be output as the tool tip or the tool center.  If Tool Center is selected,
the toolpath will be offset by the difference in the height of the tool tip and tool center.
The default value is the Tool Tip.

Center Tip

Changing machining preferences requires regeneration of machining operations to
apply the changes.

Toolpath Generation Settings

Part Sampling Resolution 
This slider is used to control the display quality of the simulated model.  Standard is
faster but with lower display quality.  For large parts, use the Standard or Medium
options, while for smaller parts Medium or Fine options would work satisfactorily.

Always generate toolpath in multiple threads 
Check this box to Always generate toolpath in multiple threads.  The system will
distribute the computing of multiple toolpaths to different cores in your processor
simultaneously rather than sequentially.  Refer to Multi-threading Manager section for
additional information.

Default Parameters

Default Knowledge Base
This allows you to select a Default Knowledge Base to load for creating machining
operations. Selecting a knowledge base as Default loads the operation parameters when
creating new operations. If no Default knowledge base is specified, the system defaults
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are used for machining operation parameters.

Source Folder for Knowledge Base
This is the source folder where the Default Knowledge Base are stored.

4.6.5.1 Multi-threading Manager

This distributes computing of toolpath to different cores in your processor simultaneously rather
than process them sequentially when regenerating multiple operations.

Multi-threading Manager

To enable generation of toolpath using multi-threading manager, select Always generate toolpath
in multiple threads from Machining Preferences located under CAM Preferences in the Machining
browser.

Regenerating the Machining Job, Setup or machining operations displays the multi-threading
manager window and indicates the progress of the toolpath computation.
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Multi-threading Manager window displayed

You can still continue working with the application when the toolpath generation is in progress
with the multi-threading manager dialog active.

4.6.6 Toolpath

These preferences relate to the graphical display of toolpath cut motions.

CAM Preferences > Toolpath
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CAM Preferences > Toolpath

Toolpath Colors

Use the color selectors to define the display color for each motion in the toolpath.  The
following can be set: Cut Motion, Plunge, Approach, Engage, Retract, Departure, Rapid
and Cut Arc.

Toolpath Display

These preferences control the display of the toolpath in the graphics window.

Toolpath Display
This refers to the graphical display of toolpaths.  Enter a value to effect the size of the
toolpath during display.

Display Tool Positions Size (Pixels)
Check this box to display tool position locators.  Each coordinate represents one tool
position.  Then enter the Pixel Size for the locator point as well as the Pixel Color of the
position points.  You can also use the color selector to assign a color to these markers.

Display Tool Axis
Check this box to display the Tool Axis line.  You can then enter a Length for the axis line
and use the Color selector to assign it a color.
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4.6.7 Simulation

You can set the simulation preferences using this dialog.  Note: Some options are not available in
XPR (Xpress) configuration.

Dialog Box: CAM Preferences > Simulation

CAM Preferences > Simulation

Simulation Model

In the RhinoCAM MILL module you can choose between two simulation models.  One is
called the Voxel Model and the other the Polygonal Model.
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Voxel Model  
The Voxel Model is a fast simulation model that is primarily used for 3 axis applications. 
It is especially useful when there are large amounts of toolpath blocks to be simulated. 
This model is fast but suffers from some accuracy limitations near vertical walls.  The
display quality of this simulation might also be insufficient for some applications
especially when simulating near vertical walls.

Polygonal Model  
The Polygonal Model on the other hand is a high quality simulation model.  This model
uses more accurate simulation algorithms at the expense of speed.  The speed of this
simulation can be relatively slow when compared to the Voxel Model.  Additionally only
the Polygonal Model of simulation can be used for 4 and 5 Axis simulations.  The Voxel
Model is limited strictly to 3 Axis applications.

Note: * This  feature i s  not ava i lable in Xpress  configuration.

Here is an example of a cylinder stock model representation with Voxel and Polygonal
model. 

Simulation Model - Voxel Simulation Model – Polygonal

Simulation Mode

You can set the simulation mode to Distance or by Motion. Simulate by Motion simulates
the toolpath based on the number of go to motions in the generated toolpath. Simulate
by Distance uses a distance based approach.

Note: * This  feature i s  not ava i lable in Xpress  configuration.

Simulation Speed

You can control the speed of the simulation using the slider bar and the
Maximum display interval. When using Simulate by distance mode, the speed is
determined as # of Motions / Distance.

Simulation Accuracy

This setting is used to control the accuracy of display of the simulated model. You can
control the accuracy of the stock model by selecting from Standard, Medium or Fine. The
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finer the stock model accuracy results in slower performance and increases the
simulation time.  

Use Specified Simulation Spacing for Voxel Model
When Voxel Model is selected (see Simulation Model above), you can also specify the
spacing for the Voxel model.  Check the box and enter the Spacing distance desired.

Stock Model Simulation Display Transparency

Use this slider to adjust the Stock Model Transparency when the Simulate tab is selected
(i.e., when you are performing a cut material simulation).

Removal of Remnants

Check this box to Remove Remnants During Simulation.  Any disassociated stock will be
removed from the simulation.

Additional Options

Stop Simulation in Error
Check this box to pause the Simulation at each error flag.  If enabled, a message will
display asking if you wish to continue with the simulation.  Selecting Play will simulate to
the next error flag and then pause. etc.

Stop Simulation at Error Flag
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Stop Simulation at Error Flag message

Disable Advanced OpenGL
Check this box only if you have an older graphics card adapter that does not support
advanced OpenGL (i.e., OpenGL 2).  Some older cards may only support OpenGL 1 for
example.  If you experience graphics instability checking this box may help resolve the
issue.

4.6.8 User Interface

From here you can set the various user interface options.

Dialog Box: CAM Preferences > User Interface
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Dialog Box: CAM Preferences > User Interface

General User Interface Preferences

User Floating Windows for Mop Dialogs 
Selecting this option displays machining operation dialogs as a floating window where
the dialog appears on top of the Machining Browser.  If the above option is unchecked
the machining operation dialog is docked and is displayed over the Machining Browser
window.

Show Getting Started Guide at startup 
This displays Getting Started dialog at program startup every time the program is loaded.
This dialog provides quick access to resources on MecSoft's website.

Run Automatic check for updates at startup 
Selecting this option automatically checks for product updates when RhinoCAM is
loaded. This requires access to internet on the computer running RhinoCAM.
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Show Configuration Selection Dialog at startup 
Selecting this option displays the product configuration dialog to run when the program
is loaded. User can select from the following MILL modules - Standard, Expert,
Professional and Premium.

Configuration Selection Dialog at startup

This dialog appears at startup when RhinoCAM is running in demo mode. 
Selecting a configuration loads RhinoCAM and provides the features available in
the selected configuration.

Show context ToolTips
Check this box to display Context ToolTips when the mouse moves over a parameter in a
dialog.  A definition of the parameter will pop-up automatically.  Note that Context
ToolTips may not be available for ALL dialogs.  You can also set the ToolTip Delay in
seconds.  This is the amount of time it takes to display the Context ToolTip when the
mouse activate it.

Show Expression Results in Tooltip
You can enter expressions in any dialog field that expects a numerical value and the
value will be computed and entered automatically.  Check this box to pop-up the results
of any expressions in a ToolTip balloon.  An example is shown below.
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Show Expressions in ToolTip

Show Insufficient Machine Axis Warning when Posting
With this checked, you will receive a warning message if the Machine Setup definition is
not set to the required number of axis for the operation being posted.  

Show Load Settings from File dialog when open file  
CAM Preferences are saved individually with each part file.  Check this box to display the
Load Settings from File dialog when a file is opened.  This gives you opportunity to NOT
have your CAM Preferences overwritten by the opened file.  

Load settings from file

Stock Information Dialog Display

Invoke 'Stock Model Information' dialog  
The Stock Model Information dialog is displayed when a stock geometry is created.
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Dialog Box: Stock Model Information

You can turn off this dialog by selecting Do not show this dialog again located on the
bottom of the message window.

To display this dialog during stock creation, select CAM Preferences > User Interface and
select Invoke ‘Stock Model Information’ dialog.

Invoke 'Run Simulation After Regeneration' dialog  
This dialog is displayed when you regenerate a Setup or the Machining Job.

Dialog Box: Run Simulation After Regeneration

Run simulation after regenerating each Machining Operation
Selecting this option simulates every machining operation in the Setup after the
operation is regenerated. This is generally selected when a re-roughing operation is part
of a Setup as it requires the in-process stock of the previous roughing operation to
generate the re-roughing toolpath.

This process would take longer processing time to regenerate all operations in a
Setup depending on the system resources and simulation preferences.

To display this dialog when regenerating a Setup, select CAM Preferences > User
Interface and select Invoke ‘Run Simulation after Regeneration’ dialog.

Invoke 'Stock from Selection Information' dialog  
This dialog is displayed when creating Stock geometry using Stock from Selection.
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Dialog Box: Stock from Selection Information

To display this dialog again when creating Stock from Selection select CAM Preferences >
User Interface and select Invoke ‘Invoke Stock from Selection Information’ dialog.

Ribbon Style

This allows the selection of different themes that changes how the Browser windows
appear. The borders, colors, highlighting, and shadowing of standard buttons, dialogs,
and windows are controlled by which theme is selected.

Example Ribbon Style: Office 2010 Silver

4.6.9 License

This dialog allows you to set Licensing Preferences for using a Proxy Server and/or a LAN Daemon
(for Network Licenses).  This information would be provided by your network administrator.

Dialog Box: License Preferences
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Dialog Box: License Preferences

Proxy Server Settings

Proxy Server Settings need to be set if your computer or network is behind a proxy.  A
proxy server is a computer that acts as an intermediary between the user's computer and
the Internet.  It allows client computers to make indirect network connections to other
network services.

Using Proxy Server
Check this box to enable Proxy Server Settings and complete ALL of the following fields
accurately.  This information would be provided by your network administrator.

Proxy IP
This is the IP Address for your Proxy Server.  This information would be provided by your
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network administrator.

Proxy Port #
Enter the Port Number for your Proxy Server.  This information would be provided by
your network administrator.

Proxy User
Enter the Proxy Server user name.  This information would be provided by your network
administrator.

Proxy
Enter your Proxy Server password.  This information would be provided by your network
administrator.

LAN Daemon Settings (for Network Licensing)

LAN Daemon Settings are used for Network licenses.  On each client machine you would
need to enter the following information in the fields provided.

Using LAN Daemon
Check this box to enable LAN Daemon Settings and complete ALL of the following fields
accurately.  This information would be provided by your network administrator.  DO NOT
check this box if you are running a node-licked license.  Node-locked refers to a single
user license.

The following message is displayed when this box is unchecked:

Daemon IP
This is the IP Address of the server that hosts the license server.  This information would
be provided by your network administrator.

Daemon Port #
Enter the port # being used by the license server.  This information would be provided by
your network administrator.

Daemon User Name
Enter the user name used to set up the account on the license server.  This information
would be provided by your network administrator.

Daemon
Enter the password used to set up the account on the license server.  This information
would be provided by your network administrator.

Network Authentication Service Settings
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Network authentication is a security process required when a computer on a network
tries to connect to the server in order to use its resources. If the user's identity has been
stored by the server, entering a valid username and password completes the connection.

Using Network Authentication
Check this box to enable Network Authentication.  Then complete the Service Server
Settings provided here.

Server IP Address
For Network Authentication, enter the Service Server's IP Address here.

Server Port #
For Network Authentication, enter the Service Server's Port # here.

Troubleshooting and Messages

Here are some troubleshooting messages that you may encounter.

If you have node locked license activated and you select Using Lan Daemon, this will
display the following message and release your node locked license.

If Using Lan Daemon is checked and you are entering a valid node locked activation code
in the license dialog, the following message is displayed.  Make sure Using Lan Daemon
is unchecked before activating a node-locked license.



RhinoCAM Profile-NEST 2020 Reference51

© 2020 MecSoft Corporation

Machining Methods

The Profile-NEST module includes the one most used 2½ Axis machining method, 2½ Axis
Profiling.  In Profile-NEST, this operation includes all of the same parameters available within
the MILL module.

5.1 2 Axis Profiling

This method machines open and closed regions by tracing along one side of their
contours. You can define offsets so that the tool makes multiple passes relative to
the regions. Profiling can be used as a finishing operation after a Pocketing or Facing
toolpath, or it can be used alone.

2½ Axis Profiling Operation Example

An example of the Profiling toolpath is shown below:

2½ Axis Profiling Operation

2½ Axis Profiling Stock Simulation Example

The stock simulation:

2½ Axis Profiling Stock Simulation
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Create Machining Operations

Creating machining operations in the Profile-NEST module is a very simple process. You load the
part, the stock geometry if necessary, selects a tool, and specify the feeds and speeds to be used
in the Profiling operation.  Generation of the toolpath begins when you select Generate from the
Profiling operation dialog. Once generated the Profiling operation will be created and displayed
under the Machining Job in the Machining Operations (Mops) Browser.  It is also displayed
graphically on the screen.

6.1 Machine Tool Setup

This option on the Program tab allows you to manually setup your Machine Tool
Definition.

Machining Browser: Machine Menu Item

The dialog can be displayed by selecting Machine from the Program tab.

Machining Browser: Machine menu item

6.1.1 Manual Definition

This dialog allows you to setup your Machine Tool Definition.  Refer to each section below for
more information.

Machine Tool Definition

Manual Definition
This option allows you to manually setup your Machine Tool Definition.  Refer to each
section below for more information.
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See Load From File, Machine Tool Setup for more information.

Dialog Box: Machine Tool Setup - Manual Definition

Machine Type

Number of Axis

· Select 3 Axis for both 2½ and 3 Axis machining methods. 

General Parameters

For all Machine Types, the following General Parameters are available.

Tool Change Point
To define a Tool Change Point, specify a coordinate location in X, Y and Z. or use the
Pick button to select a point from your 3D model.  The MILL module will output this
coordinate location for every tool change.  Note that the tool change variables must
be configured in the Post Processor.

Output all coordinates in local Setup Coordinate System
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Check this box if the G codes need to be output in the Machine Coordinate System
(MCS) setup.  Uncheck this box to output the G-code in the World Coordinate
System (WCS).

Translational Limits
This will be the Minimum X and Maximum XYZ direction Translation Limits allowed
by your machine tool.  Note: These parameters are not applied and are reserved for
future use.

This will be the Minimum X direction Translation Limit allowed by your machine
tool. Note: These parameters are not applied and are reserved for future use.

6.2 Profile-NEST Geometry

6.2.1 Part Geometry

Part Geometry is the CAD design geometry that exists in the part file. This design data could
consist of both 2D and 3D data.  Part geometry is utilized in the computation of toolpaths in the 
module.  Geometry is used in utilized differently in each of the machining operations in MILL.  

2½ Axis Profile  Typically uses 2D wireframe geometry.  3D wireframe geometry is used in some
operations and the 3D surface and/or mesh data as well as the 3D features can be optionally used
for certain computations.

6.2.2 Stock Geometry

6.2.2.1 Box Stock

You can define the raw stock model as a simple box by selecting the Box Stock option
from the Stock menu under the Program tab in Machining Browser.

Machining Browser: Box Stock menu item

Machining Browser: Box Stock menu item
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Box Stock Dialog

Use this dialog to define your box stock.  Corner position and dimension parameters are
provided.  Refer to the parameters below.  When you pick OK, a stock model based on
your definition will be created and displayed.

Box Stock Dialog

Starting Corner

Select a location from the dialog image to use as the origin to measure your stock from. 
For example: 

Set the Bottom South West corner of the Stock should serve as the origin to measured
from.  The Stock shown on your display will dynamically update accordingly.
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Bottom SW

Corner Coordinates

Alternatively, you can enter the world coordinates to determine where the corner of the
Stock Box should be located.  Your Stock Dimensions will be measured from this
coordinate point (Xc, Yc, Zc).

 You can use the Pick button to select a point from your drawing or model.

Stock Corner Coordinates

Dimensions

You can use these fields to enter the Length (L), Width (W) and Height (H) of your desired
Box Stock.

Stock Dimensions

Copy Model Bounding Box

The system calculates the bounding box extents of the part model and displays the X Y Z
Coordinate values under Dimensions L, W and H.

Calculate Bounding Box
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Ignore Wireframe Geometry in Bounds Computation

If you check the box Ignore Wireframe Geometry in Part Bounds Computation, any
wireframe geometry in your part will be ignored when calculating the Part Bounds.

Make sure to click Copy Model Bounding Box after you check or uncheck Ignore
Wireframe Geometry in Bounds Computation.

6.2.2.2 Part Box Stock

You can define the raw stock model as a simple box that surrounds your part.  This
option is available from the Stock menu under the Program tab in Machining

Browser.

Machining Browser: Part Box Stock menu item

Machining Browser: Part Box Stock menu item

Dialog Box: Part Box Stock

The system calculates the bounding box of the part model as the XYZ extents of
geometry of the part model. You can then define offsets in any of the three coordinate
directions to apply to the computed bounding box. The system will expand the bounding
box by the offset amount in each of the coordinate directions. When you click on the OK
button, a stock model based on your definition will be created and displayed.
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Dialog Box: Part Box Stock

Offsets

X Offset
Enter the X Offset value for sizing your Part Box Stock.  The system will expand
the part model bounding box by the offset amount in the +/- X direction.

Part Offset X

Y Offset
Enter the Y Offset value for sizing your Part Box Stock.  The system will expand
the part model bounding box by the offset amount in the +/- Y direction.
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Part Offset Y

Z Offset
Enter the Z Offset value for sizing your Part Box Stock.  The system will expand
the part model bounding box by the offset amount in the +Z direction.

Part Offset Z

Z Offset Direction

Both +Z and -Z / +Z Only / -Z Only

You can choose to apply the Z Offset value entered in this dialog to either the +Z
direction, the -Z direction or both +Z and -Z directions.

Ignore Wireframe Geometry in Bounds Computation

Check this to ignore all 2D and 3D curve geometries present in the part from
stock bounding box computation.

6.2.2.3 Delete Stock

You can delete the stock geometry by selecting Delete Stock from Create Stock
Model under the Program tab in Machining Browser.  The stock model can also be

deleted by selecting the stock entry under Machining Job, right mouse button click and select
Delete Stock.

Machining Browser: Delete Stock menu item
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Delete Stock Menu Item

6.3 Operations to Nest (Setup)

This icon allows you to modify the orientation of the Operations to Nest Setup (referred to as
the Machine Coordinate System or MCS) in relation to the Work Coordinate System (WCS),

the active Construction Plane or another curve or surface.

Coordinate Systems Triad Displays

The Operations to Nest Setup (MCS) is displayed on your screen as a triad Blue
representing the Z-axis, Red representing X-axis and Green representing the Y-axis. The
WCS (World Coordinate System) is displayed the same way as but with XYZ axis letters
labeled on top of it.  These are shown below.

MCS WCS

The Default Operations to Nest Setup (MCS)

When the Profile-NEST module is loaded a default Operations to Nest Setup (MCS) is
defined for you that is aligned with the World Coordinate System (WCS).  
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Operations to Nest (Setup)

To Modify the Default Setup Orientation

In PRO and higher configuration, the orientation of the default Operations to Nest Setup
(MCS) can be modified by double-left-clicking on the Setup icon to load the Setup dialog
(shown below).

Double-left-click to Edit Setup

MCS/WCS

Editing an Operations to Nest Setup (MCS) displays the Setup dialog.  This dialog allows
you to modify that Setup orientation.
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Dialog Box: Setup, Define Setup Orientation tab

Align to

Use the controls in this section to align the Z Axis of the Operations to Nest
Setup (MCS).
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Machine Coordinate System
This will orient the clearance plane parallel to the defined Setup XY (Work
Coordinate system).

Active Construction Plane
This will align the new Setup Coordinate System to the active view's
Construction Plane (C-Plane).

Select Surface
Use this option to align to a selected surface.  The surface can be selected
by using the Pick button.

Select Planar Curve
Use this option to Align To a selected curve.  The curve can be selected by
using the Pick button.

Set Orientation Parallel To

Use the controls in this section to align the Z Axis of the Operations to Nest
Setup (MCS) to one of the WCS (World Coordinate System) axes.

For the Set Orientation parallel to options, you can select either the World X
World Y or World Z buttons to along the MCS parallel to the select axis.

Rotate About

Use the controls in this section to rotate one axis or the Operations to Nest
Setup (MCS) incrementally by a defined Spin Angle.  

Note: One click of either of these Axis buttons rotates the that setup axis by
one increment.

Spin Angle
This is the incremental Spin Angle that is applied when the either the X Axis, Y
Axis or Z Axis buttons are selected from this dialog.  The spin angle can be
positive or negative.

X Axis
Rotate the Machine Tool Coordinate System one Spin Angle increment about
the X Axis.  Each pick of this button rotates one Spin Angle increment.

Y Axis
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Rotate the part one Spin Angle increment about the Y Axis.  Each pick of this
button rotates one Spin Angle increment.

Z Axis
Rotate the part one Spin Angle increment about the Z Axis.  Each pick of this
button rotates one Spin Angle increment.

Reset to Original

Pick Reset to Original to reset the MCS orientation to the current WCS
orientation.

Things to Remember about Setups

Setups cannot be edited in Xpress, Standard and Expert configurations.

Selecting Setup edits the default Setup in Professional and Premium
configurations.

6.4 Align Stock

It is typical to need the ability to position stock geometry in some geometric
relationship with the part geometry. A typical scenario is that you have modeled the

part with a pre-determined origin. In such cases it would be desirable to locate the stock with
respect to the already positioned part without having to go through actually calculating the
transformation delta values.

Machining Browser: Align Stock menu item

This dialog can be invoked by selecting Align and Align Stock from Program tab under the
Machining Browser.
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Machining Browser: Align Stock menu item

Dialog Box: Align Part and/or Stock Geometry

Once both part and stock geometry are loaded, use this dialog to perform the relative
positioning. Both Z and XY alignment of different faces of the part with respect to the
stock are possible. Select the necessary alignment options using the appropriate radio
buttons in this dialog. 
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Dialog Box: Align Part and/or Stock Geometry

X Alignment

Top  
Specify the Z Alignment of the Stock to be at the Top of the part.  The Stock preview will
be dynamically updated on your screen.

Align at Top

Center  
Specify the Z Alignment of the Stock to be at the Center of the part.  The Stock preview
will be dynamically updated on your screen.
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Align at Center

Bottom  
Specify the Z Alignment of the Stock to be at the Bottom of the part.  The Stock preview
will be dynamically updated on your screen.

Align at Bottom

XY Alignment

North West  
Specify the XY Alignment of the Stock to be at the North West of the part.  The Stock
preview will be dynamically updated on your screen.

Top
North West

Center
North West

Bottom
North West

North  
Specify the XY Alignment of the Stock to be at the North of the part.  The Stock preview
will be dynamically updated on your screen.

Top
North

Center
North

Bottom
North

North East  
Specify the XY Alignment of the Stock to be at the North East of the part.  The Stock
preview will be dynamically updated on your screen.



Create Machining Operations 68

© 2020 MecSoft Corporation

Top
North East

Center
North East

Bottom
North East

Mid-West  

Specify the XY Alignment of the Stock to be at the Mid West of the part.  The Stock
preview will be dynamically updated on your screen.

Top
Mid West

Center
Mid West

Bottom
Mid West

Center  

Specify the XY Alignment of the Stock to be at the Center of the part.  The Stock preview
will be dynamically updated on your screen.

Top
Center

Center
Center

Bottom
Center

Mid-East  

Specify the XY Alignment of the Stock to be at the Mid East of the part.  The Stock
preview will be dynamically updated on your screen.

Top
Mid East

Center
Mis East

Bottom
Mid East

South West  

Specify the XY Alignment of the Stock to be at the South West of the part.  The Stock
preview will be dynamically updated on your screen.
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Top
South West

Center
South West

Bottom
South West

South  

Specify the XY Alignment of the Stock to be at the South of the part.  The Stock preview
will be dynamically updated on your screen.

Top
South

Center
South

Bottom
South

South East  

Specify the XY Alignment of the Stock to be at the South East of the part.  The Stock
preview will be dynamically updated on your screen.

Top
South East

Center
South East

Bottom
South East

Ignore Wireframe Geometry in Bounds Computation

If you check the box Ignore Wireframe Geometry in Part Bounds Computation, any
wireframe geometry in your part will be ignored when calculating the Part Bounds.

6.5 Set World CS

You can set the location of the World Coordinate System (WCS) origin with respect
to the geometry.  An alternative way of thinking about this is to transform all loaded

geometry to an appropriate location. This Locate WCS dialog offers you a variety of ways of
accomplishing this.

Machining Browser: Set World CS menu item

This dialog can be invoked by selecting Align and Set World CS from the Nest tab under
the Machining Browser.
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Machining Browser: Set World CS menu item 

Dialog Box: Locate World Coordinate System

The Locate WCS dialog appears as shown below
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Set WCS Origin

You can set the origin by explicitly picking a point or can set it with respect to the Part or
Stock geometry bounding boxes. 

Pick  

If you select the Pick option, the button with the pick cursor  close to the bottom of
the dialog will be activated.  You can then click on this button to graphically select a point
to align the WCS origin to.

X / Y / Z / Pick  

You can set the X, Y, Z values of the WCS (World Coordinate System) manually
here.  Optionally, you can select the Pick button to select a point.  It's XYZ

coordinate values will be added to this dialog.  
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Set to Stock Box  
Selecting this item will activate the Zero Face and the Zero Position sections of the
dialog.  You can then select the Z and the XY locations, with respect to the bounding box
of the stock geometry, by choosing the appropriate selections in the dialog.

Set to Part Box  
Similar to the previous selection, selecting this item will activate the Zero Face and the
Zero Position sections of the dialog.  You can then select the Z and the XY locations, with
respect to the bounding box of the stock geometry, by choosing the appropriate
selections in the dialog.

Zero Face

Make a selection to locate the Z zero of the WCS.  This is referred to as the Zero Face. 

Highest Z 
This tells the system that the Zero Face should be at the Highest Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

Mid Z  
This tells the system that the Zero Face should be at the Mid Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

Lowest Z  
This tells the system that the Zero Face should be at the Lowest Z location of either the
Stock or Part, depending on which Set WCS Origin option is selected.

Zero Position

Make a selection to locate the Zero Position of the WCS.  You can select one of the
cardinal directions listed below.  

North West  
Locate the WCS in the XY North West position.  

North West (High/Med/Low Z)

North  
Locate the WCS in the XY North position.  

North (High/Med/Low Z)

North East  
Locate the WCS in the XY North East position.  
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North East (High/Med/Low Z)

Mid-West  

Locate the WCS in the XY West position.  

West (High/Med/Low Z)

Center  

Locate the WCS in the XY Center position.  

Center (High/Med/Low Z)

Mid-East  

Locate the WCS in the XY East position.  

East (High/Med/Low Z)

South West  

Locate the WCS in the XY South West position.  

South West (High/Med/Low Z)

South  

Locate the WCS in the XY South position.  

South (High/Med/Low Z)

South East  

Locate the WCS in the XY South East position.  
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South East (High/Med/Low Z)

6.6 Material

This allows you to assign a Material for Stock geometry. You can select a material
from the available list of materials.  Each Material has a texture that is applied to the

stock geometry and can be displayed during simulation.  Material is also used as a variable within
the Feeds & Speeds Calculator.

Machining Browser: Material menu item

This dialog can be invoked by selecting Material from Program tab under the Machining
Browser.

Machining Browser: Material menu item

Dialog Box: Select Stock Material

Choose Stock Material dialog appears as shown below.
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Dialog Box: Select Stock Material

Material File

This points to file where all materials are defined.

This xml contains the list of materials, texture, feeds and speeds. The file is
located under Materials folder in RhinoCAM. (C:\ProgramData\MecSoft
Corporation\RhinoCAM 2018 for Rhino x.x\Materials).

The Materials folder contains the following files

· FeedsSpeedsDataINCH.xml  

· FeedsSpeedsDataMM.xml  

If part unit is set to Inches, RhinoCAM automatically loads
FeedsSpeedsDataINCH.xml and when part unit is set to MM,
FeedsSpeedsDataMM.xml is loaded.

The material file is an .xml file format, which can be edited using any text editor
to add newer materials.



Create Machining Operations 76

© 2020 MecSoft Corporation

See Feeds and Speeds for information on the format of the material file and
adding new materials.

Material

This lists all materials available in the selected Material File. Selecting a
Material from the list displays the material name and material texture.

Material Texture

A preview of the Material Texture is displayed for reference.

Material Texture Visibility

Once you have defined a Material, click the Material Texture Visibility icon under
Program or Simulate tab in Machining Browser to display the texture applied to the

stock model.

Note that the Material texture only displayed when Machining Job or the Operations to
Nest is selected from the Machining Browser.

Operations to Nest (Setup)

Material Texture Displayed

6.7 Work Zero

Work Zero defines the work coordinate (part or stock) origin. This is typically done
after the MCS orientation is defined under Setup.  Work Zero translates the MCS

origin from the Setup to the desired location. This can be set to any location on the part or stock
geometry.

Refer to Machine Tool Coordinate System  for orienting the Machine Coordinate System.
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Machining Browser: Work Zero menu item

The Work Zero dialog can be invoked by selecting Work Zero from Program tab under the
Machining Browser.

Machining Browser: Work Zero menu item

Dialog Box: Work Zero

Set Work Zero dialog appears as shown below.  You can set the origin by explicitly picking
a point or can set it with respect to the Part or Stock geometry bounding boxes.  Each
option is described below.
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Dialog Box: Work Zero

Pick

If you select the Pick option, the button  with the pick cursor close to the bottom of
the dialog will be activated.  You can then click on this button to graphically select a point
to set the Work Zero to.
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Work Zero Pick Option

You can use object snaps located in VisualCAD’s status bar to snap to part
geometry.

Set to Stock Box

Selecting this item will activate the Zero Face and the Zero Position sections of the
dialog.  You can then select the Z and the XY locations, with respect to the bounding box
of the stock geometry, by choosing the appropriate selections in the dialog.

Work Zero - Set to Stock Box

Set to Part Box

Similar to the previous selection, selecting this item will activate the Zero Face and the
Zero Position sections of the dialog.  You can then select the Z and the XY locations, with
respect to the bounding box of the stock geometry, by choosing the appropriate
selections in the dialog.
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Work Zero - Set to Part Box

Selecting Ignore Wireframe Geometry in Bounds Computation ignores all 2D and 3D
curve geometries present in the part for bounding box computation.

Output Work Offset

This allows you to specify a Work Coordinate Offset number which is then output in the
posted code. This is set under Work Offset Register Number.

Work offsets are used to set work piece origin on CNC machines and this is assigned to a
register number G54, G55 etc...

Work Zero - Output Work Offset

For example:

· To output G54, set the Work Offset Register number to 54.

· The Work Offset Prefix “G” is set in the post-processor generator.

Generate

Click Generate and Work Zero is now listed under Operations to Nest and also under
Nested Sheets in Machining Browser. The MCS origin is now translated to the specified
location.
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Work Zero displayed in the Machining Browser

Work Zero Example

In the example shown below Work Zero is set to

· Set to Stock Box 

· Zero Face – Highest Z 

· Zero Position – South West 
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Dialog Box: Work Zero

Example Work Zero
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6.8 Machining Regions

Machining Regions also referred to as Control Geometry are curves or surface boundary edges that
already exist in your model or separate new curves you create that coexist within your part.  Be
sure to read the Important Notes below before proceeding.

Important Notes about Machining Regions

Machining Regions must be selected before they can be used in a
Profile operation. It should be noted that regions can be created

and be present in a part file but if they are not selected in a Profile
operation they will be ignored during toolpath computation.  So
creating a region does not make it active; you must use one of the
Selection buttons on the Control Geometry tab of the Profile
operation dialog before Generating the toolpath.

Multiple regions can be defined and selected in a Profile
operation. This is a very powerful feature and affords you fine

control over the manufacturing process.

There are two ways of working with Machining Regions.  The first
is by creating/deleting regions in a part file.  The second is

selecting regions from the Profile operation dialog. These are both
unique processes and each have independent methods of being
invoked.

Machining Region Types by Product Configuration

Machining

Region Type

Product Configuration

Xpress
(XPR)

Standard
(STD)

Expert
(EXP)

Professional
(PRO)

Premium
(PRE)

Curve

Surface Boundary/Edge

Flat Area

Avoid Regions

Creating Regions

To create regions select the Curve option from the main menu. This will bring up the
curve creation tools in Rhino. You will be able to create rectangular, circular and
polygonal regions using this toolbar. Regions can also be extracted from the 3D model
using the tools available under Curve > Curve From Objects & Curve Edit Tools.



Create Machining Operations 84

© 2020 MecSoft Corporation

Multiple Regions

Multiple and nested regions can be selected, but not regions that intersect. Nested
regions are handled according to the following rule: The tool will remain inside an outer
region and outside an inner region. A region within an inner region is considered to be
an outer region. In the following picture, the shaded areas are where the tool motions
occur:

Multiple Regions

Deleting Regions

Regions can be deleted using the tools available in Rhino  .

Editing Regions

Regions can be deleted by selecting them graphically in the display window or by using
Edit > Select Objects tools from the menu bar.  To delete the graphically selected
regions, select Edit > Cut. You can also hit the Delete key on the keyboard to delete the
active selections.

6.8.1 Selecting Curve/Edge Regions

You can select curves & edges as machining regions for any Profile operation.  You can pre-select
the regions or select the Select Curve/Edge Regions button from the Control Geometry tab of the
Profile operation dialog.

Criteria for selecting Regions

· Open and closed curves (Lines, Polylines, Arcs, Circles, Polycurves) can be
selected as regions in Profile operations.

· There is no limit on the number of curves that can be selected as regions.

· Closed curves can be nested within each other.
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Selecting Regions

 Select a Part Region first before selecting an Avoid Region.  Regions can be selected
using one of the following options:

1. Select regions using the Select button on the menu bar.

2. Select regions graphically in the display window.

3. Multiple regions can be selected by pressing the CTRL button. These selected
regions can be used to create Profile operations. The regions can be unselected
using the None option (Select > None).

4. Select regions when creating or editing a Profile operation from the Control
Geometry tab of the operation's dialog box shown below using:

Multiple Selections:

Multiple regions can be selected by pressing the CTRL button. These selected regions can
be used to create machining operations. The regions can be unselected using the None
option (Select > None).

Chain Selections:

You can automatically select a chain of curves or edges by pressing the <Shift> key while
performing a left-click selection.  This works with any curves or edges that are connected
end-to-end.

Chain Select (<Shift> + Left-click)

6.8.2 Selecting Flat Area Regions

For flat areas, you can select the Select Flat Area Regions button from the Control Geometry tab of
the Profile operation dialog.  Refer to the example below.

Flat Area Selection Example

Example
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Selecting a Flat area Feature for Profiling Profiling Toolpath generated for the Flat Area Feature

6.8.3 Selecting Avoid Regions

You can define regions to be avoided by the cutter during machining.  These regions will be
defined by 2D curves and selected from the Avoid Regions sub-tab of the Control Geometry tab of
the Profile operation dialog. 

Important Notes about Avoid Regions

Select curve(s) as a Part Regions first, before selecting an avoid
region.

Note that the toolpath uses the avoid regions as trim regions.
Which means, the toolpath will be trimmed by the avoid
regions after generation.

Example of Avoid Region

Example of Avoid Region
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6.8.4 Editing Regions

In order to use machining regions in a Profile operation, they must be first selected and made
active. This can be done in several ways.

Types of Regions

Here are the types of machining regions you can choose from:

1. Part Regions  
These are part curves that drive the location of the tool.  Defined from the Part
Regions sub-tab of the Control Geometry tab for each operation.

2. Avoid Regions 
These are 2D curve regions to be avoided by the cutter during machining.  They
are defined from the Avoid Regions sub-tab of the Control Geometry tab for each
Profile operation.

Editing Regions

Once a Profile operation is created, new regions can be selected or existing regions can
be removed from the operation as well.

To edit the list of regions used in an existing Profile operation, expand the folder
corresponding to the Profile operation in the Machining Browser window.  Then double-
click on the Control Geometry icon (1) or on the Profile operation folder (2). This will
display the Control Geometry tab for that operation. 

To Edit Control Geometry

Now you can edit the list of regions using:

· Remove All to remove all the selected regions.  

· Move Up/Move Down - these allow you to move a selected Drive Region Up or
Down in the list
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· Remove Active by selecting a region from the list of Selected Machining
Region(s)

· Select regions using the Select buttons in the dialog.

Displaying Regions

The display of the regions in the part file can be toggled on/off using the Layer Manager.

Saving/Loading Regions

Rhino allows you to save/export regions as curves in 3dm, Dxf, Dwg & other supported
formats. Such a file can then be loaded into any part file to generate machining
operations. To access the Export and the Import functions look under the File menu bar
entry.

Dialog Box: Control Geometry tab, MILL Operations
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Profile Operation Dialog Box: Control Geometry tab

6.9 Cutting Tools

MILL module allows you to define, use and archive various types of milling and drilling tools. The
tool types that are currently supported are Ball, Flat, Corner-radius or bull, VeeMill, Chamfer,
Taper, Face, Dove Tail, Fillet, Lollipop, and User Defined.

Tool Types by Configuration
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Tool
Types

Configuration

Xpress
(XPR)

Standard
(STD)

Expert
(EXP)

Professional
(PRO)

Premium
(PRE)

Ball Mills

Flat Mills

Corner Radius Mills

Vee Mills

Chamfer Mills

Taper Mills

Face Mills

Dovetail Cutters

Fillet Mills

Lollypop Cutters

User Defined Cutters

6.9.1 Create/Select/Edit Tools

To create a tool, you either selects the Create/Edit Tool option under the Tools tab in
Machining Objects Browser or alternatively by selecting the Create/Edit/Select Tool button

under the Tool tab in the machining operation.  This brings up the following dialog box that you
can utilize to create and edit tool definitions.  

Note: See Cutting Tools for a list of tools supported by Profile-NEST.

Create/Select Tools Dialog

Dialog Box: Create/Select Tools
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Dialog Box: Create/Select Tools

Create Tools Toolbar

The tool icon bar on the top of the dialog displays the all various types of tools
available in MILL module. Different tool types can be defined by selecting the
desired icon in the dialog box.

Note: The actual tools that you will see listed in this toolbar will depend on what
module and what configuration you are currently running.

Create Tools Toolbar

Tools in Session

The dialog box shows the tool name of the current selection if there is one
selected in the list-box under Tools in Session. If there is no selection then the
tool name will be the name used for a new tool definition. The list box itself lists
all of the tools of the corresponding type.
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Tools in Session

Standard APT Parameters for Tool Definition

The geometry definition of the tool contains edit boxes for the diameter, corner
radius, taper angle, flute length and the tool length. These definitions are
standard APT parameters for the tool definition. The flute length denotes the
cutting length while the tool length denotes the total length of the tool to the
tool holder.

Save/Edit/Delete Tool

Save As New Tool  
Saves a new tool and lists under Tools in Session. If a tool of same name already
exist under Tools in Session, Save as New tool button will be grayed out.
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Save Edits to Tool  
Saves edits or changes made to tool parameters.

When you Save Edits to Tool, each Mop in the Machining Job tree that
uses the Load from Tool option, will be updated with the new

feeds/speeds for that tool automatically.

Delete Tool  
Deletes the selected tool. A tool will not be deleted a tool if is being used in a
machining operation.

Tool Preview

As the tool geometry is defined, a preview of the tool is shown in the graphics
window.

Tool Preview

The Properties tab

The Properties tab to the right side of the tool preview allows you to set the Tool
Material, the Cut Material Color (for that Tool), Number of Flutes in the tool, Tool
Number, Adjust Register, Cutter Compensation Register, Axial Offset, Coolant
Type. The Number of Flutes is used in Feeds & Speeds calculations. The tool
number is used when post processing toolpaths.

The Cut Material Color selector will allow you to assign colors to each Cut
Material created by this tool.  set a  you Save Edits to Tool, each Mop in

the Machining Job tree that uses the Load from Tool option, will be updated
with the new feeds/speeds for that tool automatically.
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Cut Material by Color

The Properties tab

The Feeds & Speeds tab

The Feeds & Speeds tab located next to Properties tab allows you to set feeds and
speeds for each tool.

Refer to the Feeds and Speeds section for additional information.
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Cut Depth
You can set the Cut Depth specific for each tool you create.  If you set this
value here, you will see a Depth From Tool icon next to the Rough Depth/Cut

parameter in the Cut Levels tab of each operation where it applies. Selecting the
icon will use this value for Rough Depth/Cut. If Cut Depth is left at 0 in this dialog,
the icon will not appear in the Cut Levels tab.

The Feeds & Speeds tab

Taper Angle

Taper Angle is set for VeeMill, ChamferMill and TaperMill. This angle is the
included angle. For a 60 degree taper tool, the Taper Angle is set as 30.
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Taper Angle

Flat Diameter Examples

Flat Diameter is set for ChamferMill and TaperMill. When Flat diameter is set =0,
the tip converges to a point.

To define a ball mill with taper, set Flat diameter = 0 and Corner Radius = tool
radius.

In the example shown below, Flat Dia = 0 and Corner Radius = 0.25. This creates a
0.5” ball mill with a 10 degree taper.
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Properties tab for Taper Mill Taper Mill

In the example shown below, Flat Dia = 0.5 and Corner Radius = 0.25. This creates a
taper tool with a 10 deg taper angle, 0.5” flat diameter and 0.25” corner radius.
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Properties tab for Taper Mill

6.9.1.1 Feeds & Speeds

6.9.1.1.1  FS Calculator

This loads the Feeds & Speeds values from the Feeds & Speeds Table file.  This will display the
Load Feeds from Table dialog box to make your selections.

Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to the Feeds &
Speeds tab. The plunge, approach, engage, retract and departure feeds are determined
using a percent of the cut feed.  The percent to use for transferring the computed cut
feed can be set under Feeds & Speeds Preferences.
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Dialog Box: Load Feeds from Table

Data from Table

These selections and calculations are defined in a feeds and speeds data file which can
be edited to add newer materials.  See our blog post How to Customize Materials Data
for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds calculations.  

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are supported. 
The material is used in the tool's Feeds/Speeds calculations.  

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.



Create Machining Operations 100

© 2020 MecSoft Corporation

Feed/Tooth
Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

Input Variables

The input variables Tool Diameter and Number of Flutes are automatically loaded based
on the tool selected for the operation.  Based on these parameters, the program
computes Spindle Speed and Cut Feedrate.  Changing the Spindle Speed modifies the
Cut Feedrate.

Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values.  Once these two
values are set, the Spindle Speed and Cut Feed calculated by this dialog will not exceed
these values even if you attempt to enter higher values into the Computed Variables
fields.  To exceed these values, change them here or you must edit the operation or tool
parameters manually.  This value WILL NOT exceed the High Value set in your current
post-processor selection.  To do so you must edit the post using the Post-Processor
Generator (Program tab > Post > Current Post Processor > Edit > Feedrate > High Value).

Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based on the
selections made in this dialog but will not exceed the values set in the Maximum Limits
for Computation section of the dialog.  These values are then assigned to the active
toolpath operation or tool.  You can override either of these variables and the other will
update automatically.  Since this dialog is a Feeds & Speeds Calculator, you cannot
override both values.  To do so, you must edit the operation or tool parameters
manually.

6.9.2 Load Tool Library

This allows you to load a previously saved tool library.  

1. From the Tools tab of the Machining Objects Browser, select the Load Tool Library button

.

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate.
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Machining Objects Browser, Load Tool Library

2. Browse to the folder, double click on the desired file to load it into Profile-NEST module. 
The folder of the last loaded tool library is displayed by default. 

3. The loaded tool list will be seen under the tool button in the Machining Objects Browser.

The loaded tool list will be seen under the tool button in the browser

4. To perform the Edit, Rename, Cut, Copy or Paste operations on any of these tools, hit the
right mouse button while highlighting the desired tool.

6.9.3 Unload Tool Library

This allows you to unload the current Tool Library.  From the Tools tab of the Machining
Objects Browser, select the Unload Tool Library button.

Note: The actual icons you see in this dialog will depend on what module and what configuration
you are currently licensed to operate



Create Machining Operations 102

© 2020 MecSoft Corporation

Machining Objects Browser, Unload Tool Library

6.9.4 Add Tool Library

You can right-click on a Tool listed in the Mobs Browser to Add the Tool to an exiting Tool Library
*.csv data file.

Note: The actual icons you see in this dialog will depend on what module and what configuration
you are currently licensed to operate

Add Tool to Library

6.9.5 Select Tool from Library

This allows you to select tools from a previously saved tool library.
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1. From the Tools tab of the Machining Objects Browser, select the Select Tools from Library

button .

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate

From the Tools tab of the Machining Objects Browser, select the Select Tools from Library
button.

2. The list of tools will now be displayed under Select Tools(s) from list dialog and you can
drag and drop the tools from the selection list to the cutting tools browser.

The list of tools will now be displayed under Select Tools(s) from list dialog.

3. To Edit, Rename, Cut, Copy or Paste on any of these tools, use right mouse button click
after selecting the tool under Tools tab.
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Right-click to edit a Tool in your Tool List

6.9.6 Save Tool Library

This allows you to Save your tools to a Tool Library file.  The file can be saved in the desired
directory and read in when required.

1. From the Tools tab of the Machining Objects Browser, select the Save Tool Library button

.

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate
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From the Tools tab of the Machining Objects Browser, select the Save Tool Library button 

2. Use the File Save As dialog box to save the Tool Library file.  The folder of the last saved
tool library is displayed by default. 

File Types Supported: MILL Module supports *.vkb and *.csv. tool library file formats.  Both
formats save and load tools with the feeds and speeds assigned for each tool.

3. Specify a file name and click Save.

6.9.7 List Tools

This allows you to List and Print your tools.

1. From the Tools tab of the Machining Objects Browser, select the List Tools button .

Note: The actual icons you see in this dialog will depend on what module and what
configuration you are currently licensed to operate
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From the Tools tab of the Machining Objects Browser, select the List Tools button

2. The button brings up all the tool properties associated with the tools currently recorded in
the current session.  From the Cutting Tools Information dialog box, you can view or Print
your Tool List.

From the Cutting Tools Information dialog box, you can view or Print your Tool List

3. Pick OK to close the dialog.

6.9.8 User Defined Tools

Available in: Xpress Standard Expert Professional Premium

The MILL module allows creation of special purpose tools like form tools. These can be defined
under user defined tool in the create/select tool dialog.

User Defined Tools can be used in Drill operations to allow multi-
function tools to be defined as user defined tools and used in

drilling operations.  See User Defined Tools for more information.
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Steps to create a user defined tool

Steps to create a user defined tool

Steps to create a user defined tool:

1. Draw half the tool profile from the top view (XY plane of the world coordinate
system) as shown in the picture above and then join the curves to form a single
curve.

2. Make sure one end of the curve (tool tip) is at origin (0,0) and the other end at
X0, Y<value>.

3. From the Tools tab under the Machining Objects Browser, click Create/Select
Tool and select User Defined Tool.

click Create/Select Tool and select User Defined Tool

4. Click Load selected tool profile curve.
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Click Load selected tool profile curve

5. Specify the Holder Diameter, Holder Length, Properties, Feed & Speeds and Click
Save as New Tool.

Preview your Tool

Preview Tool allows you to preview the highlighted tool in the workspace as seen below.
The tool is previewed at the WCS origin.
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Preview your Tool

6.9.9 Cutter Compensation

Cutter Compensation is used typically to compensate for the difference in the dimensions of the
actual cutter used in machining and the cutter used for programming in MILL module.  For
example, if the cutter used in programming in MILL module is 0.25 inches and due to tool wear the
actual cutter is only 0.24 inches in size, you can compensate for this in the controller rather than
having to re-program the operation again.  Refer to the 2½ Axis Control Matrix for information
about which toolpath operations support Cutter Compensation. 

Enabling Cutter Compensation

To do this you need to do the following:

1. Turn cutter compensation on in the Operation Set Compensation to Auto/ON or
Control/ON.  
Note: Setting the Compensation to Auto/ON or Control/ON has the same
behavior in MILL module.

2. Specify the cutter compensation value and the compensation register in the
controller (the controller needs to be capable of doing this)

A few things to watch out for:
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Cutter compensation makes sense only in 2-1/2 axis operations. 
If you are using roughing (pocketing and facing) the

compensation will be turned on only in the final passes.

Make sure you are not using Zig-Zag cut traversal in any of the
methods that you want to turn compensation on.

Make sure you have a linear motion for the controller to turn on
the compensation value on.  If your first motion is an arc the

controller will not be able to turn on the compensation.  Thus, in 2-
1/2 axis profiling, make sure there is a linear entry motion for the
controller to be able to turn compensation on.

Select the Post Processor from the Post Processor generator

Select the Post Processor from the Setup tab in Machining Browser by selecting Utilities
and Post Processor generator.

Post Processor generator

6.10 Feeds and Speeds

The following Feeds & Speeds tab is displayed for all Mill operations. It allows you to select the
appropriate Feeds & Speeds for the current Mill operation. In this tab, Spindle Parameters and
Feed Rates can be specified. Speeds & Feeds can also be loaded from a File or from the Tool. 

Feed Rates Explained
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Feed Rate is one of the most important factors to consider when
implementing any CNC strategy. Simply put, feed rate is the speed
at which the cutter engages the part and is typically measured in
units/minute. Suggested cut feed rates will vary depending on the
type of material you are cutting (i.e., aluminum, steel, wood, acrylic, etc.), the material
of the cutter (carbide, high speed steel, ceramic, etc.) and many other cutting factors
including desired surface and the characteristics of the CNC machine itself.

Read the full article...

Dialog Box: Feeds & Speeds tab

Dialog Box: Feeds & Speeds tab,2 Axis Drag Knife

https://mecsoft.com/blog/feed-rates-explained/
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Spindle Parameters

These parameters refer to the spindle on your machine.

Spindle Speed  
This is the rotational Speed (S) of the milling spindle expressed in RPM.

Spindle Direction (CW)  
This sets the spindle rotation to be Clockwise (CW).

Spindle Direction (CCW)  
This sets the spindle rotation Direction to be Counter Clockwise (CCW).

Feed Rates

These are the feedrates (in Units/Min) that will be applied to the current toolpath
operation.  If the values are currently populated from your Tool definition (Load from
Tool), Feeds & Speeds table (Load from File) or from your Knowledge Base, you can
override them for this operation.

Plunge (Pf)  
This is the rate is the feed before the tool starts to engage in material. This is always
vertical.

Approach (Af)  
This is the Approach (Af) feedrate (in Units/Min) used to prepare the cutter just before
it starts to Engage into material for cutting.  Approach motions are dependent on the
method of machining.

Engage (Ef)  
This is the Engage (Ef) feedrate (in Units/Min) used when the tool is Engaging the
material just prior to cutting.

Cut (Cf)  
This is the Cut (Cf) feedrate (in Units/Min) used when the tool is Cutting material.

Retract (Rf)  
This is the Retract (Rf) feedrate (in Units/Min), when the tool is performing a Retract
move away from material.

Departure (Df)  
The is the feedrate (in Units/Min), when the tool Departs from the material.

Transfer (Tf) Use Rapid  
This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions.  If you select
Use Rapid the posted G-Code will output a rapid motion (G0) with no feed rate.  Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use. 

Transfer (Tf) Set  
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This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions.  If you select
Use Rapid the posted G-Code will output a rapid motion (G0) with no feed rate.  Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use. 

Feed Rates Reduction Factors (Hole Operations Only)

This section of the dialog allows you to specify Feed Rate Reduction Factors for specific
tool motions. 

Plunge between levels  
This is a percentage of the Cut (Cf) feedrate to use when the tool is plunging between Z
levels.

First XY Pass  
This is a percentage of the Cut (Cf) feedrate to use on the first XY cut motion when the
toolpath uses the full width of the cutter.

Coolant

Here you can override the Coolant that is specified by the Tool.  Coolant can be set to
Flood, Mist or Through.  Coolant codes are defined in the post processor generator
under Misc tab.

Load from Tool

Load the Feed & Speeds values that are saved with the currently selected Tool.

See: Create/Edit Tools

Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file.  This will
display the Load Feeds from Table dialog box to make your selections.

Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to
the Feeds & Speeds tab. The plunge, approach, engage, retract and departure
feeds are determined using a percent of the cut feed.  The percent to use for
transferring the computed cut feed can be set under Feeds & Speeds
Preferences.
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Dialog Box: Load Feeds from Table

Data from Table

These selections and calculations are defined in a feeds and speeds data file
which can be edited to add newer materials.  See our blog post How to
Customize Materials Data for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds
calculations.  

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are
supported.  The material is used in the tool's Feeds/Speeds calculations.  

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and
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Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Feed/Tooth
Selecting a Stock Material and Tool Material displays the Surface Speed and
Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Input Variables

The input variables Tool Diameter and Number of Flutes are automatically
loaded based on the tool selected for the operation.  Based on these
parameters, the program computes Spindle Speed and Cut Feedrate. 
Changing the Spindle Speed modifies the Cut Feedrate.

Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values.  Once
these two values are set, the Spindle Speed and Cut Feed calculated by this
dialog will not exceed these values even if you attempt to enter higher values
into the Computed Variables fields.  To exceed these values, change them
here or you must edit the operation or tool parameters manually.  This value
WILL NOT exceed the High Value set in your current post-processor selection. 
To do so you must edit the post using the Post-Processor Generator (Program
tab > Post > Current Post Processor > Edit > Feedrate > High Value).

Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based
on the selections made in this dialog but will not exceed the values set in the
Maximum Limits for Computation section of the dialog.  These values are then
assigned to the active toolpath operation or tool.  You can override either of
these variables and the other will update automatically.  Since this dialog is a
Feeds & Speeds Calculator, you cannot override both values.  To do so, you
must edit the operation or tool parameters manually.

The Milling Feeds & Speeds Calculator

Did you know that MecSoft’s MILL Module plug-ins have a built-in
Feeds & Speeds Calculator? That’s right, you can ask the program to
suggest feeds & speeds values based on your current stock
material and active tool parameters! Once a Cut Feed is calculated,
you can then choose to automatically assign feed rate values for
the various toolpath motions in your operation including Plunge,
Approach, Engage, Retract and Departure! The percentages of the
Cut Feed to assign are all controlled from the CAM Preferences
dialog.  The Milling Feeds & Speeds Calculator...
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Read the full article...

Customizing Feeds & Speeds

MILL module allows you to customize the feeds and speeds based on the stock material
being machined, the material of the cutter employed and also the operation type. This is
done by archiving your desired feeds and speeds settings in an external data file.

A default implementation of this table has been included with the RhinoCAM product
and can be found in a folder called "Materials" under the product installation directory.

This xml contains the list of materials, texture, feeds and speeds. The file is located
under Materials folder in the RhinoCAM install directory. (C:\ProgramData\MecSoft
Corporation\RhinoCAM 2020 for Rhino x.x\Materials).

Materials folder contains the following files

· FeedsSpeedsDataINCH.xml

· FeedsSpeedsDataMM.xml

The Feeds and speeds file is an .xml file format, which can be edited using any text
editor to add newer materials.  These values can then be recalled at any time to
compute the feeds/speeds to be used in the current program. 

The format for this file is shown below.

<Units>Imperial</Units>
<FeedsSpeeds>
 <Material>
    <Name>Stock Material</Name>
    <TextureFile>Texture Bitmap</TextureFile>
    <FeedsSpeedsRecord>Operation type, Tool Material,
Surface Speed, Feed per Tooth</FeedsSpeedsRecord>
  </Material>
</FeedsSpeeds>

An example entry is shown below.

<Material>
    <Name>ALUMINUM - 2024</Name>
    <TextureFile>ALUMINUM.bmp</TextureFile>
    <FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00,
0.0200</FeedsSpeedsRecord>

https://mecsoft.com/blog/the-milling-feeds-speeds-calculator/
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    <FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00,
0.0200</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
 </Material>

If part unit is set to Inches, MILL module automatically loads
FeedsSpeedsDataINCH.xml and when part unit is set to MM,

FeedsSpeedsDataMM.xml is loaded.

More on Customizing Materials Data

Note: This blog post is intended for advanced users who are
familiar with XML text editing and have administrative access to
their Windows Operating System.  MecSoft’s CAM plug-ins have a
built-in Feeds & Speeds Calculator that can suggest Spindle Speeds
and Cut Feed Rates based on your stock material and active tool
parameters!  However, what if you are cutting stock material that is
currently not in our Materials Library?  Or what if you don’t like
what is currently assigned for the material of your choice in the
Materials Library?  This post will show you how to customize MecSoft CAM to add and
manage multiple material files as well to add your own stock materials.  If you are new to
MecSoft’s CAM plug-ins, you can review my earlier post on the Feeds & Speeds
Calculator and how it works.

Read the full article...

6.10.1 Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file.  This will display the
Load Feeds from Table dialog box to make your selections.

Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to the Feeds &
Speeds tab. The plunge, approach, engage, retract and departure feeds are determined
using a percent of the cut feed.  The percent to use for transferring the computed cut
feed can be set under Feeds & Speeds Preferences.

https://mecsoft.com/blog/how-to-customize-materials-data-for-feeds-speeds-computation/
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Dialog Box: Load Feeds from Table

Data from Table

These selections and calculations are defined in a feeds and speeds data file which can
be edited to add newer materials.  See our blog post How to Customize Materials Data
for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds calculations.  

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are supported. 
The material is used in the tool's Feeds/Speeds calculations.  

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.
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Feed/Tooth
Selecting a Stock Material and Tool Material displays the Surface Speed and Feed/Tooth.
This information is contained in a feeds and speeds data file which can be edited to add
newer materials.

Input Variables

The input variables Tool Diameter and Number of Flutes are automatically loaded based
on the tool selected for the operation.  Based on these parameters, the program
computes Spindle Speed and Cut Feedrate.  Changing the Spindle Speed modifies the
Cut Feedrate.

Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values.  Once these two
values are set, the Spindle Speed and Cut Feed calculated by this dialog will not exceed
these values even if you attempt to enter higher values into the Computed Variables
fields.  To exceed these values, change them here or you must edit the operation or tool
parameters manually.  This value WILL NOT exceed the High Value set in your current
post-processor selection.  To do so you must edit the post using the Post-Processor
Generator (Program tab > Post > Current Post Processor > Edit > Feedrate > High Value).

Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based on the
selections made in this dialog but will not exceed the values set in the Maximum Limits
for Computation section of the dialog.  These values are then assigned to the active
toolpath operation or tool.  You can override either of these variables and the other will
update automatically.  Since this dialog is a Feeds & Speeds Calculator, you cannot
override both values.  To do so, you must edit the operation or tool parameters
manually.

6.11 Clearance Plane

The clearance plane is an XY plane wherein all transfer motions between a retract and engage
motion takes place. In the case of 4 axis operations, the clearance plane is a cylinder and defined
along the axis of rotation. Typically you would define this plane at a certain safety distance above
the part geometry. This is done to prevent the tool from touching the part being machined during
transfer motions since these motions usually use a very fast or rapid feed rate. 

Dialog Box: Clearance Plane tab
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Dialog Box: Clearance Plane tab, similar for all Milling operations

Clearance Plane Definition

This selection defines the Clearance Plane for the current toolpath operation.

Automatic  
Allow the system to calculate a the clearance plane height automatically based on the
part and stock geometry.

Automatic

Part Max Z + Dist 
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Set the Clearance Plane height to the maximum Z height of the Part plus this added
distance.

Part Max + Dist

Stock Max Z + Dist  
Select this option to use the Stock's Maximum Z height and then enter a Distance value
to add to this for the total Z height for the Clearance Plane.

Stock Max + Dist

Absolute Z Value  
Select this to specify the absolute Z clearance height to use and then enter Z height
value.  Be sure that the value you specify clears your part geometry.

Absolute Z Clearance

Ignore Wireframe Geometry in Bounds Computation  
Check this box to ignore all wireframe geometry when calculating the Clearance Plane
definition.  When checked, the Automatic and Part Max options for defining the
Clearance will be calculated from actual surface geometry.

Ignore Wireframe Geometry in Bounds Computation  
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Cut Transfer Method

This section allows you to control the tool's motions when it needs transfer to another
region to begin cutting. 

Clearance Plane  
Select this option to move the tool to the Clearance Plane and then perform the
Transfer motion to the next cut location.

Transfer at Clearance Plane

Skim  
Select this option to perform transfer motions at a Skim plane.  The system
automatically determines a safe height and then adds this Skim Clearance (C) to the
computed Z value to perform the Transfer Motions.

Transfer at Skim

Display of Clearance Plane for Milling operations

When the clearance plane dialog is active, specifying a clearance plane definition,
displays the clearance plane on the part in the view port.

Display of Clearance Plane for Milling operations



RhinoCAM Profile-NEST 2020 Reference123

© 2020 MecSoft Corporation

6.12 Tools and Utilities

CAM system Tools and Utilities provides access to G-Code Editor/Analyzer and Post
process generator.  To access the functions, select the "Utilities" option under the

Machining Browser.

 

Tools & Utilities Menu

CAM System Utilities Menu Item

G-Code Editor/Analyzer ...  
Loads the NC editor.  By default this is set to notepad.  This is specified under Program to
send posted file to which can be found in Set Post-Processor Options dialog.  Refer to Set
Post Options for additional information.

Post Processor Generator ...  
This Loads Post Processor Generator utility.

6.12.1 Shop Docs

This creates a Shop Document (i.e., a Setup Sheet) for the programmed part which includes screen
captures, estimated machining time, tool list and the machining operations list as well as stock
size and other important information.  The document can be saved in HTML or Excel format.

 

Select Shop Documentation from the Right-click Menu

Shop documentation can be generated by selecting Setup under the Program tab, right
click and select Shop Documentation. 
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Select Shop Documentation from the Right-click Menu
(Mill Module Shown)

Select Shop Documentation from the Right-click Menu
(Profile-NEST Module Shown)

The Setup Sheet is Saved and Displayed

You can select from an assortment of HTML Templates and an Excel Template from the
Save Shop Documentation File dialog and then pick Save to generate shop
documentation. This is saved as an external file and can be printed and handed over to
the operator in preparation for the part to be machined on the CNC machine.
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Sample Shop Document using Template 2

6.12.2 Toolpath Viewer

Once a machining operation is created, you can step through the toolpath motions using the
Toolpath Viewer. To display the viewer, expand the operation folder in the Machining Browser
and right-click on the toolpath icon. The toolpath viewer is a dockable dialog bar that will be
initially docked below or next to the Machining Browser. 

The Toolpath Viewer Displayed
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The Toolpath Viewer Displayed

Previewing Setup Information in the Toolpath Viewer

If the Toolpath Editor/Viewer is currently displayed, selecting Operations to Nest will
display the setup location and orientation.  Errors are flagged and displayed in the
toolpath editor/viewer if the setup orientation is not achievable.
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Setup Information is displayed in the Toolpath Viewer

Previewing a GOTO Motion in the Toolpath Viewer

Select a GOTO motion in the Toolpath Viewer to view the tool motion for the generated
toolpath. 

Make sure to turn on  Toolpath Visibility.
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Previewing a GOTO Motion in the Toolpath Viewer

6.12.3 Get Information

This displays a dialog box with the following information about the selected Operation, the Setup
or the entire Machining Job:

· Status  

· Tool Name  

· Cut Feed Rate  

· # of GOTOs  

· Machine Time  

Select Information from the Right-click Menu

Machining Operations Information can be viewed by selecting a Setup, right mouse
button click and left click on Information.
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Select Information from the Right-click Menu

Dialog Box: Machining Operations Information (MILL Module)

Dialog Box: Machining Operations Information

Optimize Machining Time Estimates!

In any MecSoft CAM product you can get an Information report
about a selected toolpath operation, a Setup or all operations in
the Machining Job. This report contains some very useful
information that includes the Tool #s used, the Cut Feed, the # of
GOTO motions and most importantly, the estimated Machining
Time.

Read the full article...

https://mecsoft.com/blog/optimize-machining-time-estimates/
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6.12.4 Save as Defaults

Save As Defaults allows you to set default parameters for machining operations. This allows the
reuse of the machining parameters without having to enter the same parameters when creating
new machining operations on same part or new part files. 

To Save As Defaults:

Step 1: Create or Select a Machining Operation

Create or Select a machining operation under the Program tab in Machining Browser.

Step 1: Create or Select a Machining Operation

Step 2: Save As Defaults

Right mouse button click on a machining operation and select Save As Defaults.
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Step 2: Save As Defaults

Step 3: Specify a File Name

This displays a Save As dialog when a default knowledge base is not specified under Set
Machining Preferences.

Specify a file name Click Save.

This creates a default knowledge base for the profiling operation and is saved to the
DefaultKB.vkb file.

The saved knowledge base is automatically set as the default knowledge base to load
under Machining Preferences and the parameters defined in the knowledge base are
used when creating a new Profile machining operation. 
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Set Machining Preferences

Step 4: Things to Remember

Save As Defaults can be set for all machining operation types.

Once a default Knowledge base is specified under Machining
Preferences, selecting Save as Defaults appends additional

parameters to the same Default knowledge base file.

If a default for a specific operation type does not exist, the
system defaults are used.

Changing the parameters saving as defaults overwrites the
default parameters with the new one.

Multiple Default Knowledge bases can be created and saved.
This could come in handy when machining different types of

materials, which requires different cutting parameters. You could
create one for machining Steel, Aluminum, Wood, etc...

Step 5: To Create a NEW Default Knowledge Base

To create a new default knowledge base:

1. Under Machining Preferences, change the Default Knowledge Base to Undefined.

2. Select a machining operation under the Machining Job, right mouse button click
and select Save As Defaults.

3. Specify a new file name and click Save. The saved knowledge base is now set as
the default knowledge base to load under Machining Preferences and the
parameters defined in the knowledge base are used when creating a new
machining operation.

Only one Default Knowledge base can be loaded at one time. You
can change the default knowledge base to load before creating a
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new machining operation.

Refer to Machining Preferences for more information on selecting
a default knowledge base.

6.12.5 Post Process Generator ...

This utility can be used to edit and set up new post-processors to be used in RhinoCAM.  The
default location of the Post File Names is selected.  Pick Browse ... to select a different location. 
Select a post processor from the list and click Edit to display the Post Processor Generator dialog
box. 
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Dialog Box: Post Process Generator

6.12.6 Explode Cabinet Design ...

This utility is ONLY available when the MILL or Profile-NEST module is loaded.  You can use this
utility to explode and layout a Cabinet Design in preparation for the NEST or MILL modules.  In the
example below, a Cabinet Design file Base.skp (created in SketchUp) was opened in Rhino.  This
utility is then used to explode and layout each planer component in the 3D part.  Once the
component geometry is exploded, you can arrange them for machining.
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Explode Cabinet Design

This utility will be affected by the CAD system's Absolute
Tolerance.  If you find that one or more geometry groups are
not being exploded, try increasing the CAD system's tolerance
settings and try again.

Explode Cabinet Design Menu Item

CAM System Utilities Menu Item

Dialog Box: Component Decomposition Control Parameters
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Dialog Box: Component Decomposition Control Parameters

Geometry Selection

You can use this section of the dialog to limit the selection of geometry to explode. 
You can select from the following:

Explode all visible  
This option will select all visible geometry in the file for use with this utility.

Explode only following layers  
This option allows you to select only geometry located on certain layers that reside
in the file.  When this option is selected, all layers present in the file are listed.  You
can check the box next to the layer(s) whose geometry you wish to select.  The
Select All and Clear All button can be used to assist in selecting layers. 

Explode selected  
This option will allow you to select the geometry you wish to explode.  With this
option selected, select the Pick button and then select the geometry to explode.

Component Placement

These options allow you to control the array placement of components on the XY
plane after exploding.  Select from the following:

Single row along X  
Select this option to arrange all components in a single row in the X direction on the
XY Plane.  Enter the Spacing between the components (refer to this value below).

Single column along Y  
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Select this option to arrange all components in a single row in the Y direction on the
XY plane.  Enter the Spacing between the components (refer to this value below).

Array with fixed distance along X  
Select this option to arrange the components along the X direction but at a fixed
distance.  This means that if the next component exceeds the Fixed Distance a new
row is created.  Enter the Spacing between components and the Fixed Distance
(refer to these values below).

Array with fixed distance along Y  
Select this option to arrange the components along the Y direction but at a fixed
distance.  This means that if the next component exceeds the Fixed Distance a new
row is created.  Enter the Spacing between components and the Fixed Distance
(refer to these values below).

Space between components

These values are available depending on the Component Placement selection
above:

Spacing  
This is the minimum distance between all components in the layout.

Fixed Distance  
This is the maximum distance allowed for the component array.  If a
component causes this distance to be exceeded it is moved to another row of
components. 

Output Geometry

These options determine the type of geometry that is created and on what layer
they are placed.  Select from the following:

Create both 3D geometry and 2D curves  
If this option is selected, both 2D curves and 3D geometry is created.

Create only 2D curves  
If this option is selected, only 2D curves are created.

Create only 3D geometry  
If this option is selected, only 3D geometry is created.

Create geometry in parent layer  
If this option is selected all 2D curves and/or 3D geometry is placed on the parent
layer of each component they were extracted from.

Create geometry in a new layer  
If this option is selected all 2D curves and/or 3D geometry is placed on a new layer
with a system generated layer name. 
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Hide original geometry  
Check this box to hide the original component geometry.  

Create separate group for each component  
Check this box to separate each decomposed component into its own geometry
group.

Place curves on one plane  
Check this box to project all curves onto the XY plane located at the world origin.

Create separate group for each component  
Check this box to group each component separately.

Save geometry colors  
Check this box to save the original geometry colors for each component.

More Information

The Explode Cabinet Design utility creates curves from 3D geometry to represent
features of interest in machining.  The following features are detected and
curves associated with these features are created with predefined colors:

Feature RGB Value Color

Through Holes RGB (255,0,255)

Blind Holes RGB (192,0. 192)

Through Pockets RGB (128,0,128)

Blind Pockets RGB (255,64,255)

Dados RGB (255,128,255)

Outer Periphery RGB (64,0,64)

6.12.7 Export to VCP

You can use this utility to export the current RhinoCAM part file (*.3dm) to a VisualCADCAM part
file (*.vcp) retaining all part geometry and existing toolpath operation definitions. 

CAM System Utilities Menu Item - Premium Configuration shown
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6.13 Error Messages

The following are some error messages that you might encounter along with some tips when
generating toolpaths using RhinoCAM.  

Invalid tool definition.

When creating/editing tools for all tools types make sure:

· Flute Length  value is set smaller than Shoulder Length and Flute Length  

· Shoulder Length value is set smaller than Tool Length  

For Dove Tail tools check values for Tool Diameter, Flute Length and Taper Angle:

· Make sure  these values are geometrically correct. Hint: Use the preview window
to see if a preview of the Tool for the specified values can be seen. 

· See Create/Edit Tools.

Could not find valid data. Internal algorithm failure.
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For 2 axis Profiling, if the toolpath you are trying to generate is on the inside of a closed
curve/sketch check:

· If Tool Diameter is larger than the width of the selected drive geometry  

For 2 Axis Re-machining when the reference Tool Diameter under the cut parameters tab
is set to be the same or less than the Tool Diameter of the tool being used for the current
operation.

Object(s) used in Machining Operation(s)! Skipping them.

This error can occur when attempting to delete a tool that is currently associated with
machining operation:

· In the Machining Objects Browser, expand the Tool icon by selecting the + sign (

 ) to see there are any operations associated with that tool.

Out of Sync

This error message tells us that Rhino's database and RhinoCAM's are not in sync. This can
occur sometimes when you have other 3rd party plug-ins running in Rhino and the
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information is not shared between RhinoCAM & the other Rhino plug-in.  Save the file in
Rhino, close and reopen RhinoCAM and regenerate the your toolpaths.
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Create Nested Sheets

Creating nested sheets of your toolpaths is performed automatically when a toolpath or the
Operations to Nest setup are regenerated.  Be sure to first define your sheets using the Add
Sheets dialog and then define your Nesting Parameters.

7.1 Nesting Parameters

This dialog is used to define the sheets in your nest.  It is divided into two parts.  The Sheets List at
the top and the Sheet Definition at the bottom.  Defining a sheet and then selecting the Add
Sheet(s) button will create the sheet and add it to the list.  Once listed, you can further control
parameters for the sheet defined by each column in the list.  Refer to each option listed below.

Nesting Parameters Dialog



RhinoCAM Profile-NEST 2020 Reference143

© 2020 MecSoft Corporation

Neting Parameters

Part Options

This section controls how toolpaths are grouped and oriented.

Orientation Step Angle
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This allows rotation of the parts to nest and can be defined by specifying orientation step
angle. For example, specifying a Step Angle of 90 would allow rotation of all parts by a
step increment of 90, which could be 90, 180 or 270 to fill the sheet optimally.

Orientation Step Angle (True Shape Nesting)

Allow Parts inside other Parts
Check this box to allow parts to be nested inside the cutouts of other parts to maximize
sheet utilization.

Checked UnChecked

Use for Engraving & Sign Making
Check this box to use nesting for engraving & sign making.  This allows the ability to nest
curves inside a hole as shown below.  In this example, the outer rectangle would be the
part and the exterior & interior of the letters would be treated as holes.

Use for engraving & sign making

Nesting Options

This section controls distances and accuracy of the nested toolpaths.

Distance Part to Part
This parameter defines the minimum distance between each part within a sheet. In the
example below, Distance Part to Part is set = 0.25. and Distance Part to Sheet= 0.
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Distance Part to Part

Distance Part to Sheet
This parameter defines the minimum distance between parts to the edge of the sheet. In
the example below, Distance Part to Part is set = 0.25. and Distance Part to Sheet = 0.50.

Distance Part to Sheet

Overflow Minimum Utilization %
This defines the minimum percent of material utilization that is permitted on any sheet
in the nest.  If set, then the % of utilization of material for each sheet must exceed this
value.  If the % of utilization for any sheet is below this value, that sheet will be
suppressed from the nest.

This can be used to eliminate remnants on the last sheet
used which typically has the lowest % of utilization.

Accuracy
Move this slider to adjust the Simulation Accuracy (Standard, Medium and Fine).  This
refers to the display accuracy.  For example, in Polygonal Mode, more polygons will be
added, thus increasing display accuracy.

Auto Tab Options

Use this section to auto tag your nested toolpaths.

Tag Nested Curves Automatically
Tagging allows you to identify nested parts.  Check this box to turn Tagging On.
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Auto Tag Output
Annotation - The tag number is shown on the screen as graphics display text only.  The
height of the annotation text is dynamically controlled by the Tag Text Height value.

Annotation Tagging

Geometry - The tag number is created as geometry curves, which are selectable as
geometry.  Enter the Tag Text Height for tagging.

Geometry Tagging

Tag Text Height
This value is the Text Height for each generated Tag.  When Annotation is selected, the
Tag is only displayed graphically on the screen using the Text Height value.  When
Geometry is selected, the Tag geometry will equal the actual Text Height value. 

Nested Sheets Layout

Use this section to define the layout of the nested sheets. 

Along X
Pick Along X to layout the nested sheets along the X direction (left to right) beginning at
the XY origin.

Along Y
Pick Along Y to layout the nested sheets along the Y direction (bottom to top) beginning
at the XY origin.

Spacing between Sheets
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If either Along X or Along Y is selected, enter a distance value for the Spacing Between
Sheets.

Output Sorting

Use this section to determine how the machining operations (Mops) are listed in the
Machining Job tree.  The sorting is performed within each nested sheet folder in your
Machining Job. 

Sort Mops by
Select a sorting method:

Default  
Mops are sorted in the order they appear in your Operations to Nest setup. 

Tool Size ASC  
Mops are sorted by ascending tool size (smaller tool diameters first). 

Tool Size  
Mops are sorted by descending tool size (larger tool diameters first). 

Estimate # of Sheets

Select this button and the system will estimate how many sheets are needed and allow
you the opportunity to update your sheet count.

Estimate # of Sheets

Execute Nest

Pick Execute Nest to calculate the final Nest based on all parameters and selections you
have made.  You are then moved to the Preview Nest tab automatically.

7.2 Add Sheets to Nest

This dialog is used to define the sheets in your nest.  It is divided into two parts.  The Sheets List at
the top and the Sheet Definition at the bottom.  Defining a sheet and then selecting the Add
Sheet(s) button will create the sheet and add it to the list.  Once listed, you can further control
parameters for the sheet defined by each column in the list.  Refer to each option listed below.
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Select Sheets Dialog

Add Sheet to Nest

Sheets List

Description

#
Sheets are automatically numbered at the time of creation.

Name
This is the name of the sheet provided when it was created.

Count
This is the total quantity for this sheet.

Thickness
This is the designated thickness for the sheet.

Starting Corner
This is the starting corner for the toolpath operations nested on this sheet.

Starting Corner  

Nesting Direction
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This is the direction that toolpath operations will be nested on this sheet.  For example,
beginning at the Lower Left, operations would nested from left to right (Along X).

Nesting Direction

Grain Direction
This is the grain direction for the sheet.  It can be used to control how toolpath
operations are oriented on the sheet.  For example, if you select Along X here and then
select Along Y for Grain Direction on the Nest Parameters tab of the toolpath operation
dialog, then that toolpath would be rotated 90 degrees on this sheet.

Grain Direction

Select Curve(s)
Pick this button to select geometry to be used as Sheets.  You may window-select all
closed curves and press <Enter> or <Right-Click> to add them to the selection list. 
Selecting open profiles is not supported.  Sheets are Only periphery shapes and cannot
contain holes or cutouts. test

Remove All
Pick this button to remove ALL items from the list.

Remove Active
Select the Remove Active button to remove the currently selected item from the list.

Sheet Definition
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Use these controls to define the parameters for a new sheet.  Once the fields are
defined, pick the Add Sheet(s) button to add the sheet to the list above.

Name
This will be the Name of the defined sheet.

Length
This will be the Length of the defined sheet measured in the default drawing units.

Height
This will be the Height of the defined sheet measured in the default drawing units.

Thickness
This will be the Thickness of the defined sheet measured in the default drawing units.

Count
This will be the Count total for the defined sheet.

Add Sheet(s)
After entering the sheet dimensions and attributes, select this button to add the sheet
to the sheets list.

7.3 Nesting Report

This dialog display a report of the current nested sheets.  First regenerate your Operations to Nest
setup.  This will update your nested sheets.  Then display this report to get information on the
Nested Sheets results. 

Nesting Report Dialog

Nesting Report
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2 Axis Profiling

Profiling, 2½ Axis

2 Axis Profiling is a toolpath method that employs
regions and can be used either as a pre-finishing
operation or as a finishing operation. These regions are
treated as the tops of vertical walls spanning from the Z

values of the regions down to your specified cut depth. 

This system does not consider any part surface geometry during
computation. The tool types commonly used in this method are Flat
End Mills.  The operation cuts in parallel XY  planes until the desired
depth is reached.

As the cutter follows these horizontal planes, it can maintain a climb,
conventional o mixed cut direction.

2 Axis Profiling Example

2½ Axis Profiling

2 Axis Profiling Menu Item

The Profiling toolpath method is invoked by selecting the Program tab and clicking on
the 2½ Axis Profiling operation menu selection.
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2½ Axis Profiling Menu Item

2 Axis Profiling Dialog

Here is a typical 2 Axis Profiling operation dialog with the Cut Parameters tab selected.
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Cut Parameters Tab, 2 Axis Profiling
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8.1 Control Geometry

Control Geometry refers to the part geometry that controls the current operation.  2 Axis
operations can use 2D and even 3D curves and surface edges as Control Geometry.  For 2 Axis
operations, Control Geometry is divided into two possible categories: Part Regions and Avoid
Regions.  The Control Geometry tab has sub-tabs for selecting each of these categories of
geometry from your part.

Regions must be selected before they can be used in an
operation. It should be noted that regions can be created and

be present in a part file but if they are not selected in a machining
operation then they will be ignored during toolpath computation. 
So creating a region does not make it active; you must use one of
the select button from the Control Geometry tab of the Profile
operation before you select Generate.

Region Types by Configuration

Region Type

Configuration

Xpress
(XPR)

Standard
(STD)

Expert
(EXP)

Professional
(PRO)

Premium
(PRE)

Curve

Surface Edge

Flat Area

Avoid Regions

Note: Some region types are not supported by all operation types.

Dialog Box: Control Geometry tab
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Control Geometry tab, Profiling, 2 Axis

Part Regions tab
The Part Regions tab displays in all 2½ Axis and some 3 Axis operations.  It is used to drive
the tool during the operation.  Use one of the Select... buttons in this dialog to add Part
Regions to the Selected Machining Region(s) list.

See Select Part/Containment Regions for more information.

Avoid Regions tab
The Avoid Regions tab lists the geometry (i.e., Regions) to be avoided by the cutter
during the current Mill operation.  The outer diameter of the tool will not enter this
region.
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Note: This  feature i s  not ava i lable in Xpress  configuration.

See Avoid Regions for more information.  This tab is available on the following operation
dialogs: Facing, 2½ Axis, Pocketing, 2½ Axis, Profiling, 2½ Axis

Move Up
This button moves the selected item up (i.e., higher) in the list.  Items are machined in
the order listed.

Move Down
This button moves the selected item down (i.e., lower) in the list.  Items are machined in
the order listed.

Remove All
If your controller does not support spiral g-code motions, check this box to output spiral
motions as linear segments.

Remove Active
Pick this button to Remove the selected Active region from the list.  You can select
multiple Regions from the list using the Ctrl key and then pick this button to remove
them all.  The geometry itself is not deleted from the part model.

Select Curve/Edge Regions
Pick this button and the dialog will minimize, prompting you to make a selection from
your part.  You can select curves or face edges.  After completing the selection, the dialog
will re-appear with your Region selections listed.

Select Surface Boundary
Pick this button and the dialog will minimize, prompting you Select surface for boundary.
 You can select one or more part surfaces.  After completing the selection, the dialog will
re-appear with each surface edge boundary listed in the Selected Machining Region(s)
list.

Select Flat Area Regions
Pick this button and you are prompted to make a selection from your part.  You can select
flat planar face geometry.  After completing the selection, the dialog will re-appear with
your region selections listed.

8.2 Cut Parameters

This Cut Parameters tab is similar for the Mill operations listed below.  It allows you to define the
cut parameters for the current Profiling operation.  You can set Global Parameters, Cut Direction
and the Stepover Distance via this tab of the operation dialog.  The Global Parameters section
allows you to set the tolerance value to be used in machining.  A uniform thickness or stock that
needs to be left around the part can also be specified here.  Refer to each option below. 

Dialog Box: Cut Parameters tab, Profiling Operations
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Cut Parameters tab, Profiling Operations

Global Parameters
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The Global Parameters section allows you to set the tolerance value to be used in
machining. A uniform thickness or stock that needs to be left around the part can be
specified here.

Tolerance
This is the allowable deviation from the actual part geometry plus the Stock allowance
(if any).  In 2 Axis methods, this Tolerance is applied to XY motions only.

Tolerance

How to Increase Tool Path Accuracy

Tolerances play a vital role in both design engineering
and digital manufacturing.  In design, the goal is to allow
the broadest tolerance range possible while meeting
your design specifications. This is because, generally
speaking, there is a direct correlation between tighter
tolerances and higher manufacturing costs.

Read the full article...

Stock
This is the thickness of the layer that will remain on top of the part after the toolpath is
complete. Roughing operations generally leave a thin layer of stock.  For finishing
operations this value is zero.

Stock

Compensation
This enables cutter compensation.  The compensation direction, left or right, is
determined by the Cut Direction selected (Climb or Conventional).

Cut Direction

Climb (Down Cut)  
Select Climb (Down Cut) and the tool will be maintained in a downward motion into
the stock.

https://mecsoft.com/blog/how-to-increase-tool-path-accuracy/
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Climb (Down Cut)

Conventional (Up Cut)  
Select Conventional (Up Cut) and the direction of the tool will be maintained in an
upward motion out of the stock.

Conventional (Up Cut)

Mixed
Select Mixed and the direction of cutting is alternated between each parallel plane. 
This is a mixture of both Climb and Conventional cutting of the stock.

Mixed

Understanding Climb vs Conventional Milling

One of the basic concepts to understand in any milling
operation is Cut Direction.  It can be characterized by
how the flutes of the cutting tool engage the stock
material and form the chip that is removed during
cutting. In many of MecSoft CAM’s 2½ & 3 Axis toolpath
strategies you will see that Cut Direction is defined by
selecting one of three options, Climb, Conventional or
Mixed.  Let’s take a look at the characteristics of each
option.

Read the full article...

For Z Level Cuts:
When Mixed is selected, zigzag motions are applied between step downs to eliminate
tool retracts between z levels.  If Climb or Conventional is selected, retract between z
levels are applied.  Refer to the images below:

https://mecsoft.com/blog/understanding-climb-vs-conventional-milling/
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Climb or Conventional Mixed

Cut Start Point for Closed Curves

Check this box to move the cut start point to the mid-point of the longest side of a
closed curve.

Use Midpoint of Longest
Curve

Cutting Side

Specify

Select this option to activate the Cutting Side parameters in this dialog.

Right of Curve / Left of Curve
Right or Left determines the side of the curve to cut.  This can be set for both
open and closed curves.  Right or Left is determined by the start point and
direction.

Cut Start Side

Use Inside/Outside for Closed Curves
Select this option if you have a closed curve region.  Then select Inside or
Outside to have the tool cut on that side.
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Inside
Outside

Alternate using Nesting
If your control geometry has nested curves, check this box to alternate the cut
side (i.e., Outside/Inside or Inside/Outside).

On  Off

Stepover Control

This is how wide your cut should be.  The Step/Cut determines your stepover.  For
example if Total Cut Width is set to 1.0 and Step/Cut is set to 0.25, there will be 4 passes
created.

Total Cut Width

This will determine the stepover for each cutting pass beginning at your total cut width
and ending at your control geometry.

Total Cut Width  

Corner Cleanup

Check the Corner Cleanup box to automatically detect corners that the tool could not
reach between each pass.  The system will then add a toolpath based on the uncut area
detected.
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8.3 Cut levels

The following Cut Levels tab allows you to define the location of the Cut Geometry and various
Rough and Finish Cut Level parameters.  Refer to each of the sections below for more information.
 MecSoft Tech Blog: Understanding Cut Levels in 2½ Axis Machining.

Dialog Box: Cut Levels tab

Cut Levels tab, MILL Operations

Location of Cut Geometry

The Location of Cut Geometry can be set to At Top (top Z level), At Bottom (bottom Z
level) or Pick Top (specifying the Z location) by entering a Z value location or by

https://mecsoft.com/blog/understanding-cut-levels-in-2%C2%BD-axis-machining/
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selecting the pick  button and selecting the point on the part.

At Top

This uses the Z location of the selected Machining Feature/Region as the top of
cut. The generated cuts will start at this Z location and cut down in Z to the
specified total cut depth. At Top is typically used when you select the top edge as
your machining region.

Feature/Region at Top Feature/Region at Top - Toolpath

At Bottom

This uses the Z location of the selected Machining Feature/Region as the bottom
of cut. The generated cuts will be above the selected machining region and last
cut would be at the Z location of the specified region. At Bottom is typically used
when you select a pocket bottom at your machining region.

2½ Axis Facing Operation Examples:

Feature/Region at Bottom Feature/Region at Bottom - Toolpath

Pick Top

This allows you to specify the Top of Cut for the selected Machining
Feature/Region and is typically used when the selected region is not at top or
bottom. The generated cuts will start at this specified Z location and cut down in Z
to the specified total cut depth. This would be useful when the selected
machining region is at the bottom edge of a fillet or chamfer.
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When two or more curves are selected as Machining Features/ Regions, and using
Pick Top for Location of Cut Geometry, sets the Top of cut for all regions at the
same Z level.

2½ Axis Facing Operation Examples:

Feature/Region pick Top Feature/Region pick Top - Toolpath

Cut Depth Control

The Cut Depth Control section provides controls for defining the depth of the cut. First
define the Total Cut Depth.  Then, enter the Rough Depth and Finish Depth values.  You
can then define the Depth per Cut for both Rough and Finish passes by entering values.

Total Cut Depth
Enter the Total Cut Depth or select the Pick button and select two points on your
part.  The depth will be calculated automatically and added to this dialog.  Refer to

the illustration below for reference.  You can then divide this into a Rough Depth and
Finish Depth.

Total Cut Depth

Rough Depth
AFTER the Total Cut Depth is specified, enter your Rough Depth value.  For example, if
you enter 1.0 for the Total Cut Depth, the Rough Depth and Rough Depth/Cut will
automatically default to 1.0.  If you then enter 0.75 as the Rough Depth, the Rough
Depth/Cut will default to 0.75 also until you adjust it.

Finish Depth
AFTER the Total Cut Depth and the Rough Depth are specified, you can enter a Finish
Depth value.  This value is optional.  You can then proceed to enter a Finish Depth/Cut
value.

Rough Depth/Cut
AFTER the Rough Depth is specified, you can use the Rough Depth/Cut field to tell the
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system how deep to cut each level until the Rough Depth is achieved. 

Select this icon to assign the Cut Depth value that is defined by the tool that is
currently active for this operation.  Note: This icon will ONLY appear in this dialog if

the currently active tool has a Cut Depth value assigned to it.  Edit the tool definition if
desired.

Finish Depth/Cut
AFTER the Finish Depth is specified, you can use the Finish Depth/Cut field to tell the
system how deep to cut each level until the Finish Depth is achieved. 

Select this icon to assign the Cut Depth value that is defined by the tool that is
currently active for this operation.  Note: This icon will ONLY appear in this dialog if

the currently active tool has a Cut Depth value assigned to it.  Edit the tool definition if
desired.

Clear Island Tops

Check this box to insert an extra cut level at the top of any inner islands or connected
step regions.

Use 3D Model to Detect Depth

Check this box ONLY when a 3D model is being used.  When checked, the bottom most
level of the part is detected (if there are multiple depths) and cut levels will be added
to this depth level. Only the Finish Depth (under Cut Depth Control) needs to be
specified. The Rough Depth is automatically determined. For multiple pocket
selections, the Location of Cut Geometry should all be the same level (i.e., either all At
Top, At Bottom or Picked Top).

Cut Level Ordering

Depth First allows you to order the Cut Levels in this operation so that the entire Z
depth of each feature is machined before moving on to the next feature.

Level First allows you to order the Cut Levels in this operation so that all regions in a
single Z level are machined first before moving on to machine the next cut level.

8.4 Entry/Exit

The following Entry/Exit tab is similar for the Mill operations listed below.  Entry and Exit
determines the way in which tool enters and leaves the part geometry. MILL Module allows you to
specify how the cutter approaches, engages, retracts and departs when starting and stopping a
cut. 

Dialog Box: Entry/Exit tab
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Dialog Box: Entry/Exit tab, 2½ Axis Milling operations

Entry Motions

You can set different feeds for plunge, approach, engage, cut, retract and depart
moves.  The tool moves to the position above the approach point with a plunge
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feed, then uses the approach feed rate for the vertical approach motion and
engage feed rate for the engage motion.

Lines & Arcs 
This is a 2D entry motion consisting of an Approach Motion and an Engage Motion. 

For the Approach Motion, enter the approach Length (L).  Then, depending on the
stock material and cut pattern select the approach angle as either Normal, Tangent
or Specify Angle (A) with respect to the stock.

For the Engage Motion select Linear or Radial.   In the Linear motion the cutter
follows a linear ramp motion, Ramping back and forth from a user specified height
to the engage point. The Length (L) of this move, as well as the Angle (A) of this
motion can be specified.

Linear Radial

Along Path  
The Entry path can be defined as a 3D Entry along a specified Path Angle with a
Path Height. 

Along Path

None 
No entry motion is defined for the current operation.

None

Exit Motions

The Exit motion consists of a Retract Motion followed by a Departure Motion. The
departure motion is a linear motion.

Lines & Arcs  



2 Axis Profiling 168

© 2020 MecSoft Corporation

The 2D Exit motion consists of Approach Motion and an Engage Motion.  You can
set the Retract Motion to Linear and then enter the Length (L) and the Angle (A). 
Likewise you can select Radial and then simply enter the Radius (R).

Linear Radial

For the Departure Motion, enter the departure Length (L).  Then, depending on the
stock material and cut pattern select the departure angle as either Normal,
Tangent or Specify Angle (A) with respect to the stock.

None  
No exit motion is defined for the current operation.

None

Apply entry/exit at each cut level

Check this box to apply the Entry/Exit Motions to each cut level.

Overlap Dist for Closed Profiles

This option allows you to specify an overlap distance for closed profiles to avoid
leaving small tool marks at the start point of the part. The toolpath will start as
specified, follow the closed profile back to the start point and then continue past for
the specified distance. The overlap distance will be restricted so that it cannot exceed
the profile length.
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Overlap Distance not set Overlap Distance set

8.5 Advanced Cut Parameters

The following Advanced Cut Parameters are similar for the Mill operations where the tab is
available.  Some parameters listed below may not be supported for every applicable operation. 
These parameters can be used to control the cuts for high speed machining and are designed to
reduce rapid acceleration and deceleration of the machine during the cutting process.  They allow
smoothing of the toolpaths by introduction of arcs. 

You can use these parameters even if the controller does not
support arcs. In this case, make sure that the output is set to Linear

output. This can be set in the Set Machining Preferences dialog located
on the Machining Browser under CAM Preferences.

Dialog Box: Advanced Cut Parameters tab

Some options shown below are not available for all operations.
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Dialog Box: Advanced Cut Parameters tab, Profile Operation

Cut Corner Rounding Options

Check this box to round sharp corners in the toolpath and specify a Rounding
Radius (r).  Fillets of the specified radius will be introduced in sharp corners if
possible. These fillets will only be introduced on planes parallel to the XY plane.



RhinoCAM Profile-NEST 2020 Reference171

© 2020 MecSoft Corporation

Perform Cut
Rounding

Cut Arc Fitting

Check this box to Perform Arc Fitting .  The system will attempt to fit arcs along the
computer toolpath if they lie within the three principal planes (XY Plane, XZ Plane
or YZ Plane).

Tolerance (t)

Smooth Cut Transitions

Check this box to add "S" or "C" shaped cut transitions between two successive offset
cuts that lie parallel to the XY plane.  These Smooth Cut Connections reduce rapid
acceleration and deceleration on the machine and extend tool life.

Smooth Cut Connections

Bridges/Tabs

For the 2½ Axis Profiling operations, select None, Triangular or Rectangular to create
bridges along the part boundary.  These bridges can be used to hold the part on the
table during the actual machining operation.  The following parameters are supported:

· Bridge Height (H):  See illustrations below.

· Bridge Length (L):  See illustrations below.

· Reduce feed on descending motion:  

Check this box to reduce the feed rate for the descending motion after each tab.  The
reduction is governed by the Plunge between levels percentage value defined by the
Feeds & Speeds tab of the operation.
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Reduce Feed when
Descending  

· Number of Bridges:  See note 1 below.

· Distance between Bridges:  See note 1 below.

None Rectangular Tabs Rectangular Tabs

Bridges-and-Tabs-Explored

You may have heard the term Bridges & Tabs mentioned often
enough during our many videos and blog posts. Let’s take a
moment to explore exactly what they are and how they can be
used effectively. Because CNC machining is a subtractive
manufacturing process, stock material needs to be removed by the
cutter until the resulting part’s shape is achieved. During this
process, the remaining part needs to be fixed and stable on the bed of the CNC machine
tool so that accuracy is maintained during the entire machining process.

Read the full article...

8.6 Cornering Parameters

The following Cornering Parameters are available for all Profiling operations.  You can control
both External Corners and Interior Corners.  You can also filter which corners these controls are
applied to by specifying a corner angle range.  Please be sure to read the notes below before
using these parameters and perform cut material simulations to fully understand how they affect
cutter movement.

Important Note:  These Internal and External Corner Types require
that the Control Geometry selected for the Profiling operation be

closed regions or open poly-lines.  If your Control Geometry is a single
line or multiple disconnected lines, you must use the Default
selections or an error message will be returned.

https://mecsoft.com/blog/bridges-tabs-explored/
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You can use these parameters even if the controller does not
support arcs. In this case, make sure that the output is set to Linear

output. This can be set in the Set Machining Preferences dialog located
on the Machining Browser under CAM Preferences.

Tip: Location of Start Points:  If the start point is at a vertex where
the corner is being applied, it is automatically moved to the corner. 

Dialog Box: Cornering Parameters tab
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Dialog Box: Cornering Parameters tab, Profiling, 2 Axis

External Corner Type

The External Corner Type selected will be applied to all corners measured
between the Minimum Angle and Maximum Angle values provided.

Round (Default)  
This the default External Corner Type.  The tool rolls around the sharp corner. 
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Depending on the toolpath Tolerance, this method can cause rounding of the sharp
corner.  NOTE: This option must be used if your Control Geometry is not closed or
is not a ploy-line! 

Round

Sharp  
This External Corner Type will force the tool to proceed past the corner vertex. 
When the tool diameter becomes tangent with the projected edge direction, it
proceeds along the secondary edge.

Sharp

Sharp Limited  
This External Corner Type will force the tool to proceed past the corner vertex by a
specified Overshoot Length.  If the Overshoot Length is specified as a distance less
than the tool radius, a round is added at the corner.  The radius of the round is
equal to the tool radius minus the Overshoot Length.  If the Overshoot Length is
equal to or greater than the tool radius the Sharp Corner Type is used.

Sharp Limited

Loop  
This External Corner Type will force the tool to proceed past the corner vertex by a
specified Loop Radius before it proceeds tangent to the secondary edge.  The
radius is measured tangent to the secondary edge.

Loop
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External Corner Filters

Minimum Angle  
This is the Minimum Angle for corners to be considered for an External Corner
Type.  Corner angles below this value will use the default round method for
external corners.

Maximum Angle  
This is the Maximum Angle for corners to be considered for an External Corner
Type.  Corner angles above this value will use the default round method for
external corners.

Internal Corner Type

The Internal Corner Type selected will be applied to all internal corners measured
between the Minimum Angle and Maximum Angle values provided.

Sharp (Default)  
This is the default Internal Corner Type.  The tool will change directions when it meets
the approaching edge.  NOTE: This option must be used if your Control Geometry is not
closed or is not a ploy-line! 

Sharp

Dog Bone  
In this Internal Corner Type, the tool will stop when it meets the approaching edge and
then proceed directly to the corner vertex point.  The tool will then reverse direction
back to the previous point and proceed tangent with the approaching edge.

Dog Bone

T-Bone  
In this Internal Corner Type, the tool will stop when its diameter meets the
approaching edge and then continue tangent until it reaches the corner vertex.  The
tool will then reverse direction back to the previous point and proceed tangent with
the approaching edge.
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T-Bone

Internal Corner Filters

Minimum Angle  
This is the Minimum Angle for corners to be considered for an Internal Corner Type. 
Corner angles below this value will use the default sharp method for internal corners.

Maximum Angle  
This is the Maximum Angle for corners to be considered for an Internal Corner Type. 
Corner angles above this value will use the default sharp method for internal corners.

8.7 Sorting

The following tab allows you to define Sorting parameters for the current Profiling operation.  If
No Sort is selected, operations will be performed in the order in which the regions were created
or selected. The Minimum Distance Sort and Directional Sort options are described below. 

Dialog Box: Sorting tab
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Dialog Box: Sorting tab, similar for 2½ Axis Hole Making, Pocketing & Profiling Operations

No Sort

If No Sort is selected, operations will be performed in the order in which the regions
were created or selected.

Minimum Distance Sort

This option sorts based on the shortest distance between regions based on the start
point of the regions. This option allows you to set the sort based on the Start point. 
This start point can be one of the following:
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Start Point - Lower Left Start Point - Lower Right

Start Point - Upper Left
Start Point - Upper Right

Directional Sort

The directional sorting is performed according to the Primary and Secondary sort
directions. The Primary Sort Direction (P) is defined by Start Angle (A). 

The Secondary Sort Direction (S) is always perpendicular to primary direction and can
be defined to go from Low to High value or from High to Low value.  In addition to this
the traversal of the cutter can also be defined as either Zig (one way) or ZigZag (two
ways). Refer to the dialog box images below: 

Low to High, Zig Pattern

Low to High, ZigZag Pattern
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High to Low, Zig Pattern High to Low, ZigZag Pattern

Perform Clustering (not available for all operation types)

These parameters allow you to sort machining regions by clusters.  A cluster is when
one region is completely enclosed within the boundary of another region.  This
relationship defines one cluster.  There can be multiple clusters selected for an
operation and these options will sort them for machining. 

Perform Clustering
Check this box to enable clustering and then select which method to use.  A cluster is
when multiple regions are completely enclosed within the boundary of another region.

No Clustering

Inside/Out
Select this option to machine one complete cluster at a time starting with all of its inner
regions first before machining its outer region. 
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Inside/Out Clustering

Outside/In
Select this option to machine one complete cluster at a time starting with its outer
region before machining all of its inner regions. 

Outside/In Clustering

8.8 Tool Tab

The following dialog allows you to select the appropriate tool for the current operation.  The Tools
in Session are listed on the left.  Expanding the Tool tree will list the current operations assigned
to that tool.  See Create Edit Tools for more information. 

Dialog Box: Tool tab



2 Axis Profiling 182

© 2020 MecSoft Corporation

Dialog Box: Tool tab, similar for all Milling Operations

Edit/Create/Select Tool ...

If there are no Tools listed, select this button to Create a new tool.  If a tool is listed
and selected by default, select this button to Edit the parameters for that tool or to
Select a different tool for the current operation.

Preview Tool

Select this button to display a graphical representation of the currently selected tool. 
This is the same Preview of the tool that you see displayed in the Edit/Create/Select
Tool dialog.
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8.9 Feeds & Speeds

The following Feeds & Speeds tab is displayed for all Mill operations. It allows you to select the
appropriate Feeds & Speeds for the current Mill operation. In this tab, Spindle Parameters and
Feed Rates can be specified. Speeds & Feeds can also be loaded from a File or from the Tool. 

Feed Rates Explained

Feed Rate is one of the most important factors to consider when
implementing any CNC strategy. Simply put, feed rate is the speed
at which the cutter engages the part and is typically measured in
units/minute. Suggested cut feed rates will vary depending on the
type of material you are cutting (i.e., aluminum, steel, wood, acrylic, etc.), the material
of the cutter (carbide, high speed steel, ceramic, etc.) and many other cutting factors
including desired surface and the characteristics of the CNC machine itself.

Read the full article...

Dialog Box: Feeds & Speeds tab

https://mecsoft.com/blog/feed-rates-explained/


2 Axis Profiling 184

© 2020 MecSoft Corporation

Dialog Box: Feeds & Speeds tab,2 Axis Profiling

Spindle Parameters

These parameters refer to the spindle on your machine.

Spindle Speed  
This is the rotational Speed (S) of the milling spindle expressed in RPM.

Spindle Direction (CW)  
This sets the spindle rotation to be Clockwise (CW).

Spindle Direction (CCW)  
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This sets the spindle rotation Direction to be Counter Clockwise (CCW).

Feed Rates

These are the feedrates (in Units/Min) that will be applied to the current toolpath
operation.  If the values are currently populated from your Tool definition (Load from
Tool), Feeds & Speeds table (Load from File) or from your Knowledge Base, you can
override them for this operation.

Plunge (Pf)  
This is the rate is the feed before the tool starts to engage in material. This is always
vertical.

Approach (Af)  
This is the Approach (Af) feedrate (in Units/Min) used to prepare the cutter just before
it starts to Engage into material for cutting.  Approach motions are dependent on the
method of machining.

Engage (Ef)  
This is the Engage (Ef) feedrate (in Units/Min) used when the tool is Engaging the
material just prior to cutting.

Cut (Cf)  
This is the Cut (Cf) feedrate (in Units/Min) used when the tool is Cutting material.

Retract (Rf)  
This is the Retract (Rf) feedrate (in Units/Min), when the tool is performing a Retract
move away from material.

Departure (Df)  
The is the feedrate (in Units/Min), when the tool Departs from the material.

Transfer (Tf) Use Rapid  
This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions.  If you select
Use Rapid the posted G-Code will output a rapid motion (G0) with no feed rate.  Note:
For more accurate machining time estimates, use the Set option and enter the feed
rate to use. 

Transfer (Tf) Set  
This is the Transfer (Tf) feedrate (in Units/Min) used for Transfer motions.  Select Set to
enter an actual feedrate value for rapid motions (G0).  This is only used for calculating
the estimated machining time.

Feed Rates Reduction Factors (Hole Operations Only)

This section of the dialog allows you to specify Feed Rate Reduction Factors for specific
tool motions. 

Plunge between levels  
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This is a percentage of the Cut (Cf) feedrate to use when the tool is plunging between Z
levels.

First XY Pass  
This is a percentage of the Cut (Cf) feedrate to use on the first XY cut motion when the
toolpath uses the full width of the cutter.

Coolant

Here you can override the Coolant that is specified by the Tool.  Coolant can be set to
Flood, Mist or Through.  Coolant codes are defined in the post processor generator
under Misc tab.

Load from Tool

Load the Feed & Speeds values that are saved with the currently selected Tool.

See: Create/Edit Tools

Load from File

This loads the Feeds & Speeds values from the Feeds & Speeds Table file.  This will
display the Load Feeds from Table dialog box to make your selections.

Dialog Box: Load Feeds from Table

Selecting OK from this dialog transfers the spindle speed and cut feedrate to
the Feeds & Speeds tab. The plunge, approach, engage, retract and departure
feeds are determined using a percent of the cut feed.  The percent to use for
transferring the computed cut feed can be set under Feeds & Speeds
Preferences.
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Dialog Box: Load Feeds from Table

Data from Table

These selections and calculations are defined in a feeds and speeds data file
which can be edited to add newer materials.  See our blog post How to
Customize Materials Data for Feeds & Speeds Computation for more details.

Stock Material
Select the desired Stock Material from this list to use in Feeds/Speeds
calculations.  

Tool Material
Select the desired Tool Material from this list. CARBIDE, HSS CERAMIC are
supported.  The material is used in the tool's Feeds/Speeds calculations.  

Surface Speed
Selecting a Stock Material and Tool Material displays the Surface Speed and
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Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Feed/Tooth
Selecting a Stock Material and Tool Material displays the Surface Speed and
Feed/Tooth. This information is contained in a feeds and speeds data file
which can be edited to add newer materials.

Input Variables

The input variables Tool Diameter and Number of Flutes are automatically
loaded based on the tool selected for the operation.  Based on these
parameters, the program computes Spindle Speed and Cut Feedrate. 
Changing the Spindle Speed modifies the Cut Feedrate.

Maximum Limits for Computation

Here you can set the Max Spindle Speed and Max Cut Feed (Cf) values.  Once
these two values are set, the Spindle Speed and Cut Feed calculated by this
dialog will not exceed these values even if you attempt to enter higher values
into the Computed Variables fields.  To exceed these values, change them
here or you must edit the operation or tool parameters manually.  This value
WILL NOT exceed the High Value set in your current post-processor selection. 
To do so you must edit the post using the Post-Processor Generator (Program
tab > Post > Current Post Processor > Edit > Feedrate > High Value).

Computed Variables

The variables for Spindle Speed and Cut Feed (Cf) are computed for you based
on the selections made in this dialog but will not exceed the values set in the
Maximum Limits for Computation section of the dialog.  These values are then
assigned to the active toolpath operation or tool.  You can override either of
these variables and the other will update automatically.  Since this dialog is a
Feeds & Speeds Calculator, you cannot override both values.  To do so, you
must edit the operation or tool parameters manually.

The Milling Feeds & Speeds Calculator

Did you know that MecSoft’s MILL Module plug-ins have a built-in
Feeds & Speeds Calculator? That’s right, you can ask the program to
suggest feeds & speeds values based on your current stock
material and active tool parameters! Once a Cut Feed is calculated,
you can then choose to automatically assign feed rate values for
the various toolpath motions in your operation including Plunge,
Approach, Engage, Retract and Departure! The percentages of the
Cut Feed to assign are all controlled from the CAM Preferences
dialog.  The Milling Feeds & Speeds Calculator...
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Read the full article...

Customizing Feeds & Speeds

MILL module allows you to customize the feeds and speeds based on the stock material
being machined, the material of the cutter employed and also the operation type. This is
done by archiving your desired feeds and speeds settings in an external data file.

A default implementation of this table has been included with the RhinoCAM product
and can be found in a folder called "Materials" under the product installation directory.

This xml contains the list of materials, texture, feeds and speeds. The file is located
under Materials folder in the RhinoCAM install directory. (C:\ProgramData\MecSoft
Corporation\RhinoCAM 2020 for Rhino x.x\Materials).

Materials folder contains the following files

· FeedsSpeedsDataINCH.xml

· FeedsSpeedsDataMM.xml

The Feeds and speeds file is an .xml file format, which can be edited using any text
editor to add newer materials.  These values can then be recalled at any time to
compute the feeds/speeds to be used in the current program. 

The format for this file is shown below.

<Units>Imperial</Units>
<FeedsSpeeds>
 <Material>
    <Name>Stock Material</Name>
    <TextureFile>Texture Bitmap</TextureFile>
    <FeedsSpeedsRecord>Operation type, Tool Material,
Surface Speed, Feed per Tooth</FeedsSpeedsRecord>
  </Material>
</FeedsSpeeds>

An example entry is shown below.

<Material>
    <Name>ALUMINUM - 2024</Name>
    <TextureFile>ALUMINUM.bmp</TextureFile>
    <FeedsSpeedsRecord>MILLING, CARBIDE, 1600.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>MILLING, HSS, 400.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>MILLING, CERAMIC, 400.00, 0.0040</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, CARBIDE, 960.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, HSS, 240.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>DRILLING, CERAMIC, 240.00, 0.0048</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>TURNING, CARBIDE, 1800.00,
0.0200</FeedsSpeedsRecord>

https://mecsoft.com/blog/the-milling-feeds-speeds-calculator/
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    <FeedsSpeedsRecord>TURNING, CERAMIC, 1800.00,
0.0200</FeedsSpeedsRecord>
    <FeedsSpeedsRecord>TURNING, CERMET, 1800.00, 0.0200</FeedsSpeedsRecord>
 </Material>

If part unit is set to Inches, MILL module automatically loads
FeedsSpeedsDataINCH.xml and when part unit is set to MM,

FeedsSpeedsDataMM.xml is loaded.

More on Customizing Materials Data

Note: This blog post is intended for advanced users who are
familiar with XML text editing and have administrative access to
their Windows Operating System.  MecSoft’s CAM plug-ins have a
built-in Feeds & Speeds Calculator that can suggest Spindle Speeds
and Cut Feed Rates based on your stock material and active tool
parameters!  However, what if you are cutting stock material that is
currently not in our Materials Library?  Or what if you don’t like
what is currently assigned for the material of your choice in the
Materials Library?  This post will show you how to customize MecSoft CAM to add and
manage multiple material files as well to add your own stock materials.  If you are new to
MecSoft’s CAM plug-ins, you can review my earlier post on the Feeds & Speeds
Calculator and how it works.

Read the full article...

8.10 Clearance Plane

The clearance plane is an XY plane wherein all transfer motions between a retract and engage
motion takes place. In the case of 4 axis operations, the clearance plane is a cylinder and defined
along the axis of rotation. Typically you would define this plane at a certain safety distance above
the part geometry. This is done to prevent the tool from touching the part being machined during
transfer motions since these motions usually use a very fast or rapid feed rate. 

Dialog Box: Clearance Plane tab

https://mecsoft.com/blog/how-to-customize-materials-data-for-feeds-speeds-computation/


RhinoCAM Profile-NEST 2020 Reference191

© 2020 MecSoft Corporation

Dialog Box: Clearance Plane tab

Clearance Plane Definition

This selection defines the Clearance Plane for the current toolpath operation.

Automatic  
Allow the system to calculate a the clearance plane height automatically based on the
part and stock geometry.

Automatic

Part Max Z + Dist 
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Set the Clearance Plane height to the maximum Z height of the Part plus this added
distance.

Part Max + Dist

Stock Max Z + Dist  
Select this option to use the Stock's Maximum Z height and then enter a Distance value
to add to this for the total Z height for the Clearance Plane.

Stock Max + Dist

Absolute Z Value  
Select this to specify the absolute Z clearance height to use and then enter Z height
value.  Be sure that the value you specify clears your part geometry.

Absolute Z Clearance

Ignore Wireframe Geometry in Bounds Computation  
Check this box to ignore all wireframe geometry when calculating the Clearance Plane
definition.  When checked, the Automatic and Part Max options for defining the
Clearance will be calculated from actual surface geometry.

Ignore Wireframe Geometry in Bounds Computation  
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Cut Transfer Method

This section allows you to control the tool's motions when it needs transfer to another
region to begin cutting. 

Clearance Plane  
Select this option to move the tool to the Clearance Plane and then perform the
Transfer motion to the next cut location.

Transfer at Clearance Plane

Skim  
Select this option to perform transfer motions at a Skim plane.  The system
automatically determines a safe height and then adds this Skim Clearance (C) to the
computed Z value to perform the Transfer Motions.

Transfer at Skim

Display of Clearance Plane for Milling operations

When the clearance plane dialog is active, specifying a clearance plane definition,
displays the clearance plane on the part in the view port.

Display of Clearance Plane for Milling operations
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Edit Operations

Once a Profile operation is created it is listed under the Machining Browser. By default all the
operations are created under the setup named Operations to Nest.  The setup can hold several
Profile operations and each operation can be associatively edited and regenerated. 

The Program Tab of the Machining Browser

Changes can be made to any of the objects that make up the operation such as the
Control Geometry, Tool, Feeds/Speeds, Clearance Plane and Machining Parameters.  Any
edits made to an operation are saved with the operation and upon regeneration the
changes will take affect.

Machining Browser

9.1 Edit Associatively

Profile operations can be edited by using the Machining Browser.  Each operation is represented
as a folder in the browser.  In the expanded state of a Profile operation folder, seven icons
representing different objects that make up the operation are displayed.  The first five can be
associatively edited.
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The Machining Operation Tree Icons

The following icons are displayed under a machining operation's folder and represent
the different objects that make up the operation.  The first five (Machining Features,
Tool, Feeds/Speeds, Clearance Geometry and Parameters) can be associatively edited.

Operation Folder Expanded

Double Click to Open an Operation Dialog for Editing

Double clicking on the operation folder (or name) will open the operation's properties
dialog with all tabs displayed for editing.

Double Click to Open a Machining Operations Dialog for
Editing
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Right or Double Click one of an Operation's Icons to Edit its Properties

Right mouse click or double clicking a specific icon, for example the Tool icon would
bring up the Tool Creation dialog, upon which you can substitute the current tool with
another or edit the parameters of the current tool.

Click on this Icon Displays the Operation's

Control Geometry tab

Tool tab

Feeds/Speeds tab

Clearance tab

Cut Parameters tab

Toolpath in the Toolpath Viewer

Right or Double Click one of an Operation's Icons to Edit its Properties

Drag & Drop a Tool from the Object Browser to an Operation
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The tool can also be edited by dragging and dropping a tool from Tools tab to the
Machining Browser.

Drag & Drop a Tool from the Object Browser to an Operation

Display of Operations that need Regenerating after Editing

If any of the objects that make up the operation were to be edited after the toolpath was
initially generated, the operation will be flagged dirty (i.e., needing regeneration).  This

condition is indicated by adding a red marker  to the operation folder.  Also, the

object that necessitated this condition  is also displayed with a red marker.

An example of this is shown below. In this case the tool used in the operation was edited
after the machining operation was created and so is shown differently, as is the
operation.
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Display of Operations that need Regenerating after Editing

Profile operations will be flagged if any associated parameters outside of the operation
are edited.  For example, if the geometry is modified, all Profile operations dependent
on that geometry will be flagged for regeneration.  In the example below you see that
the Profile folder, Control Geometry and the In-process Stock are flagged, letting you
know that the operation needs to be regenerated and simulated.

Regenerating "Flagged" Machining Operations

In order to regenerate the operation that is flagged with a red marker, you would have to
select the operation, right click and select Regenerate.
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Right-click on an Operation and Select Regenerate

The toolpath is now generated with the modified settings.  Notice that the In-process
Stock is still flagged.  This alerts you that it has not been simulated yet.

Machining Operation is Regenerated

9.2 Copy/Paste

You can Copy and Paste machining operations in Machining Browser. To Copy an operation, select
the operation under the Machining Browser, right-click and select Copy.

Copy the Operation
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Machining Browser: Copy an Operation

Paste the Operation

Right click on the operation and left click on Paste.
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Machining Browser: Paste an Operation

Edit or Regenerate the Operation

This creates a copy of the operation located under the currently selected operation.  If
you picked Yes to the Execute Nest message dialog, additional sheets are added to the
Nested Sheets list to accommodate the additional operation.
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Pasted Operation & Additional Nested Sheets

You can then edit the operation and regenerate toolpath.

9.3 Delete

To Delete a machining operation, select it from the Machining Browser, right click and select Cut
from the context menu.

Cut an Operation
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Delete from Right-Click Menu

Alternate Methods to Delete an Operation

Alternatively you can delete a machining operation by:

· Selecting the operation and pressing the Delete key on your keyboard.

· Selecting the operation and dragging the operation out of the mops browser to
the viewport area.

9.4 Rename

You can Rename a machining operation or the Setup in the Machining Browser by selecting it,
right click and select Rename from the context menu.
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Select Rename from the Right-click Menu

Select Rename from the Right-click Menu

Selecting Rename allows you to edit the operation name.

Edit the Operation's Name

Conventions for Renaming Operations

Do not use any of these common illegal characters/symbols in your Mop Names:
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DO NOT USE these Characters when renaming Mops

# pound ? question mark

% percent / forward slash

& ampersand $ dollar sign

{ left bracket ! exclamation point

} right bracket ' single quotes

\ back slash " double quotes

< left angle bracket : colon

> right angle bracket @ at sign

* asterisk

Also, keep these rules in mind:

· Do not start or end your Mop Names with a space or period

· Keep your file names to a reasonable length and be sure they are under 31
characters.

9.5 Suppress

You can Suppress a machining operation in the Machining Browser by selecting it, right click and
select Suppress from the context menu.  Suppressed operations will not be displayed, posted or
simulated.  You can also right-click and Unsuppress an operation.

To Suppress an Operation
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To Suppress an Operation

The Suppressed Operation Icon

A Suppress operation will display in the Machining Job with the following icon:

Suppressed Operation Icon

To Unsuppress an Operation
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To Unsuppress an operation, right-click on it and select Unsuppress. 

To Unsuppress an Operation

9.6 Edit Properties

You can set the properties of a Operation by selecting it in the Machining Browser window,
clicking on the right mouse button and selecting the Properties menu item.

Select Properties from the Right-click Menu (in the MILL Module)
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Select Properties from the Right-click Menu

Dialog Box: Machining Operation Properties

This will bring up the dialog that is shown below.
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Dialog Box: Machining Operation Properties

Name  
Change the Name of the Machining Operation.  

Program #  
Specify Program # for the operation.  This program number will be output during post
processing of the operation.

Simulation Color  
This allows you to specify a unique color for this operation during Simulation display. 
Refer to the Simulate tab Status Bar for setting the simulation to display by Mop (i.e.,
machining operation type).

Comments to Output  
You can also include commands that will be saved with the operation.  These comments
will also be output during post-processing of the operation.  This might be a good place
to put in comments or instructions for the machine tool operator.

This can be used to put in add comments or instructions for
the machine tool operator!

Previously Output To File  
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This refers to the name of the external post-processed file that this particular operation
was output to.

Previously Output On  
This refers to the last time the operation was post-processed and the time the post-
processing was performed.
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Simulate

MILL module offers very powerful cut material simulation functionality to allow you to simulate
actual machining of the generated toolpaths. The output of this simulation is a true 3D cut model.
This 3D model can be rotated, zoomed and manipulated. 

This cut model can be visually compared with the part model to show areas of uncut material
and/or areas of over-cut material using this component. The simulation features allow the early
detection and correction of programming errors.  

3 Types of Simulation Available

There are three kinds of toolpath simulation available in MILL module. These are

1. Tool Animation  

2. Cut Material Simulation   

3. Machine Tool Simulation  

The simulation can be performed either on the currently active machining operation or
on multiple operations.

Simulate the Active Operation

The active operation is the one that is selected and shown highlighted in the Machining
Browser.  Typically, this would be the last toolpath that was generated.  To simulate any
operation, select the operation in the browser and click Simulate from simulate tab of
the browser or by using right click and Simulate.

Simulate the Active Operation

Simulate Multiple Operations
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To perform simulation on multiple operations select the last operation, right click and
choose Simulate Until.  You can also select multiple operations by holding down the Ctrl
key.

Simulate Until the Active Operation

Simulate all Operations within the Operations to Nest (Setup)

Alternatively you can select a Setup and select Simulate to simulate all the operations
within a Setup. 

Simulate all Operations within Operations to Nest (Setup)

Simulate one or more Nested Sheet

You can also simulate one or all of your currently nested sheets or one or more nested
operations within a nested sheet.  You can use the same selection and right-click options
on sheets as you can of operations. you can select a Setup and select Simulate to
simulate all the operations within a Setup. 



RhinoCAM Profile-NEST 2020 Reference213

© 2020 MecSoft Corporation

Simulate a Nested Sheet

Simulate all Nested Sheet
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Simulate one or more Nested Operations

10.1 Tool Animation

Available in: Xpress Standard Expert Professional Premium

Simple tool animation can be carried out in MILL module by using the controls on the Simulate
tab. If there is no stock loaded or if the stock is loaded and the stock visibility is turned off then
the tool can be animated to follow the toolpath by setting the step increment to the desired value
and clicking on the Simulate button on the Simulate tab of the browser or by selecting an
operation and choosing right click to simulate.

Location of the Toggle Stock Visibility Icon

You can also choose to display the toolpath as the tool is being animated. This is a powerful
function that allows you to actually watch the toolpath being displayed on the screen
incrementally. To do this make sure Toolpath Visibility is turned on before starting the tool
animation along the toolpath.
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Location of the Toggle Toolpath Visibility Icon

 Tool Animation

10.2 Cut Material

Available in: Xpress Standard Expert Professional Premium

As mentioned earlier, the Profile-NEST module offers very powerful cut material simulation
functionality to allow you to simulate actual machining of the generated toolpaths. To perform
cutting simulation, a Stock model must be defined and displayed and a machining operation must
be active.

Location of the Toggle Stock Visibility Icon
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Location of the Toggle Stock Visibility Icon

Selecting Play on the Simulate tab simulates the selected operation.

An Example of Cut Material Simulation

The output of this simulation is a true 3D cut model. This 3D model can be rotated,
zoomed and manipulated. This cut model can be visually compared with the part model
to show areas of uncut material and/or areas of over-cut material using this component.
An example of cut material simulation is shown below.

An Example of Cut Material Simulation

An Example of Voxel Simulation Visual Artifacts

When the Simulation Model is set to Voxel, in some cases, especially when simulating
cutting of vertical walls (as is typically done in 2 axis machining), the Voxel simulation
model leaves visual artifacts at these areas. The reason for this is that the Voxel
simulation model display resolution is not very high along the Z-axis. This causes jagged
areas to be displayed under these circumstances. It should be emphasized that these are
purely visual artifacts and do not represent the true output that would be generated on
the machine tool.  An example of this visual artifact is shown below.  To avoid this,
change the Simulation Model to Polygonal under Preferences..
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An Example of Visual Artifacts

10.2.1 Advanced Engine

Available in: Xpress Standard Expert Professional Premium

There are two material removal simulation modes (or models) available for use. The main
advantage of the Voxel method is very rapid processing times.  The Polygonal method is more
comprehensive and results in better display quality, however at the expense of speed.

To change the simulation module in the Profile-NEST module, select Simulation Preferences
located under the Simulate tab or select CAM Preferences > Simulation Settings button under the
Machining Browser and select the appropriate model for simulation.

Refer to Simulation Preferences for a detailed description.

Voxel Simulation Polygonal Simulation

10.3 Material Texture

Material texture can be applied to your cut material simulations. This functionality allows you to
simulate actual machining of the generated toolpaths with material textures applied.

To Prepare for Cut Material Simulation with Material Texture

1. Stock model must be defined and displayed.

2. Material must be defined under the Program tab

3. Turn on Material Texture Visibility 
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Location of the Material Texture Visibility Icon

4. A machining operation must be active.

To Perform the Simulation

Then using the controls in the Simulate tab of the Machining Browser you can perform
the cutting simulation.

See Material for a detailed description.

Example of Cut Material Simulation with Material Texture

An example of cut material simulation with material texture is shown below. The
Material is set to Wood under Choose Stock Material.

Example of Cut Material Simulation with Material
Texture
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Post-Process

Once nested sheets are created they can be post processed to a specific machine controller. To
post process a nested sheet, select the Sheet in the browser, right click and select Post.  The
product comes with a set of over 300 post-processors to choose from.

Example of Posting a Nested Sheet.

Example of Posting a Nested Sheet

Post-processing Multiple Machining Operations

You have the ability to select multiple operations within a nested sheet of machining
and post process them with a single button click. To do this expand the nested sheet,
select the operations and right click and select Post.

You can select multiple operations by holding down the Ctrl key.

Example below shows posting multiple machining operations.



Post-Process 220

© 2020 MecSoft Corporation

Selecting multiple operations by holding down the Ctrl key for posting

Post from the Program & Simulate tabs

Post-processing can be done from the Program or Simulate tabs under the Machining
Browser.

Selecting Post will display the Post and Save As Dialog.

The following are the default settings when the Post and Save As Dialog is displayed.

· Post & Save As Dialog points to the folder location where the part geometry is
located.

· Save as type – this refers to post file extension. This information is obtained from
the Program tab > Set Post Options dialog.

· Current Post - this refers to the controller/post processor to post process the
toolpath. This information is also obtained from the Program tab > Set Post
Options dialog.

You can override the default settings using the Post & Save As Dialog.

Select Post and the posted file will be written to the specified folder.
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Dialog Box: Post & Save As

Tool Number Validation during Posting

Tool number conflicts are flagged before post-processing multiple operations.  If
multiple machining operations use different tools but with one or more coincident tool
numbers, you are notified of this condition with the following message:

11.1 Set Post Options

You can specify certain post-processor options and rules for post processing. This is
done by selecting "Set Post Options" from the Program tab under the Machining

Browser.

This will bring up the following dialog.

Dialog Box: Set Post-Processor Options
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Dialog Box: Set Post-Processor Options

Current Post Processor

User can change the default post processor by selecting a post from the list of available
post processors under Current Post Processor.

Folder where post-processor files are located

MILL module uses macro files with a .spm extension to handle post-processing to
different controllers. These files are typically located in the "Posts" directory under the
RhinoCAM installation folder(C:\ProgramData\MecSoft Corporation\RhinoCAM 2020 for
Rhino x.x\Posts\Mill).



RhinoCAM Profile-NEST 2020 Reference223

© 2020 MecSoft Corporation

MILL module by default looks in this directory to build the list of available post-
processors shown under the Current Post. User can change the post processor by
selecting a post from the list of available post processors under Current Post.

To change the post processor file location, you can specify the folder to find the Post-
Processor macro files by selecting the "Browser for Folder" button in the dialog.

Program to send the Posted file to

This feature allows you to specify a program to display the posted file. This could be a NC
editor or a text editor like Notepad.

You could also have this point to your control software’s
executable file and RhinoCAM will automatically launch this

application when the machining operations are post processed.

Posted File Naming Conventions

This allows you to set rules for posted file name when post processing machining
operations.

When a machining operation is selected for posting you can set the output file name
from one of the following options. 

· Part File Name + Machining Operation Name  

· Part File Name + Setup Name + Machining Operation Name  

· Setup Name + Machining Operation Name  

· Machining Operation Name  

When a setup is selected for posting you can set the output file name from one of the
following options. 

· Part File Name + Setup Name  

· Setup Name  

When Machining Job is selected to Post All, you can set the output file name from one of
the following options. 

· Part File Name  

· Part File Name + First Setup Name  

· First Setup Name  

Posted File extension

You can select a posted file extension from the list or add an extension to the list by
selecting Add new button. This displays the Post File Extension dialog shown below
where you can specify a new file extension and click OK.
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Dialog Box: Post File Extension

The new file extension is now set as your posted file extension automatically.

By default RhinoCAM performs interactive post-processing. That is, when you select a
toolpath for post-processing, RhinoCAM launches the post-processor and waits for it to
complete.  You can also turn off the display of the output dialog (post and save dialog).

During interactive post-processing, RhinoCAM launches the NC editor to view the output
file. You can specify a different NC editor to use.  See Program to send the Posted file to
above for doing this.
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Archive

Once machining operations are created they can be archived along with the Rhino part (.3dm) file.
 This can be accomplished by simply saving the part file.  When the part file is retrieved, all
archived operations will be loaded along with the part file.
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Find More Resources

Download this PDF Guide for a list of the available RhinoCAM Resources.

2020 RhinoCAM Resource Guide

The RhinoCAM 2020
Resource Guide!

18 Pages

Lists PDF downloads and Online resources including Quick Start
Guides, Reference Guides, Exercise Guides, Tutorials and
More.

Click Here to download this guide!

https://www.mecsoft.com/guest/Support%20Documents/2020/RhinoCAM-2020/RC2020-Resource-Guide.pdf
https://www.mecsoft.com/guest/Support%20Documents/2020/RhinoCAM-2020/RC2020-Resource-Guide.pdf
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